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Beta Features Disclaimer
This is beta documentation for one or more beta software features.

• Beta features are considered unreleased and have not been fully tested nor fully validated. The
results are not guaranteed by Ansys, Inc. (Ansys) to be correct. You assume the risk of using beta
features.

• At its discretion, Ansys may release, change, or withdraw beta features in future revisions.

• Beta features are not subject to the Ansys Class 3 error reporting system. Ansys makes no com-
mitment to resolve defects reported against beta features; however, your feedback will help us
improve the quality of the product.

• Ansys does not guarantee that database and/or input files used with beta features will run suc-
cessfully from version to version of the software, nor with the final released version of the features.
You may need to modify the database and/or input files before running them on other versions.

• Documentation for beta features is called beta documentation, and it may not be written to the
same standard as documentation for released features. Beta documentation may not be complete
at the time of product release. At its discretion, Ansys may add, change, or delete beta document-
ation at any time.
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Chapter 1: Activating Mechanical Beta Options
To make beta options available:

From Workbench

1. On the Workbench Project page, from the Tools menu, Options and then selection of the option
Appearance.

2. Scroll down and activate the Beta Options check box.

3. Click OK.

4. Open or return to Mechanical.

From Mechanical

1. Open the Options dialog by selecting the File tab and then Options. You can also select the
Options icon beside the Quick Launch field on the title bar.

2. Open the Common Setting option and select the User Interface category.

3. Set the Show Beta Options preference to Yes.
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Chapter 2: Two-dimensional (2D) Acoustics Analyses
Using Beta Options (p. 1), you can perform a two-dimensional (2D) acoustics analysis.

• 2D Acoustics is supported in Coupled Field Analyses. Supported in the following analyses:

– Coupled Field Harmonic

– Coupled Field Modal

– Coupled Field Static

– Coupled Field Transient

• Supported with other physics and coupling such as:

– Structural Acoustics

– Acoustics with Piezoelectric Coupling

– Acoustics with Electrostatic force coupling

– Applicable Boundary Conditions are supported

– Applicable results are supported

Note:

Far Field results are not yet supported.
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Chapter 3: Maintain Coordinate System Scoping
During Model Assembly
The model assembly feature of Workbench and Mechanical enables you to import multiple meshed-
based geometries into a single downstream Mechanical analysis system by linking the upstream Model
cells to the Model cell of the downstream system.

Using a beta option, you can now maintain the geometry-based scoping of Coordinate System objects
from upstream system(s). Currently, imported Coordinate Systems only include their location and direc-
tions and not the geometry selection specified in the upstream system.

In Workbench, in addition to activating the Beta Options (p. 1), you must also activate the feature
selection option (Options > Tools> Mechanical) highlighted below. You need to close and reopen the
Workbench application before the capability becomes available.

The following examples show a Coordinate System created in an upstream system and imported into
a downstream system.

Upstream System

5
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.



Downstream System

Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.6

Maintain Coordinate System Scoping During Model Assembly



7
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.



Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.8



Chapter 4: Using Degenerated Tetrahedral Elements
For structural and thermal analyses, the Degenerated Shape (Beta) property can be specified to have
the application use degenerated tetrahedral elements on geometry parts.

Application

1. Activate Beta Options (p. 1).

2. Select the Geometry object and set the Element Control property to Manual.

3. Select the desired body object and specify one of the following for the Degenerated Shape (Beta)
property:

• Program Controlled (default): The application selects the suitable element type.

• Yes: The solver will use linear order degenerated tetrahedral elements. For example, in the case
of a structural analysis the application would use SOLID185.

• No: The solver will use linear order tetrahedral elements. For example, in the case of a structural
analysis, the application would use SOLID285.

Note:

This property is only applicable for a solid geometry that:

• Is not generated from Pull objects.

• Is not a rigid body.

• Has a linear order tetrahedral mesh.

Supported Analysis Types

• Eigenvalue Buckling

• Harmonic Response

• Modal

• Static Structural

• Substructure Generation

• Steady-State Thermal

9
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.



• Transient Structural

• Transient Thermal
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Chapter 5: Import Velocity and Synchronize Analysis
Settings for H5DPF Files
When importing velocities from an upstream External Data system using an *.h5 file, the imported
data often contains numerous orders or frequencies, each with multiple RPM values. Use the context
(right-click) menu beta option, Create Velocities and Sync Analysis Settings (Beta), to automatically
synchronize the Analysis Settings of the downstream system with the imported velocity data.

Procedure

1. Activate Beta Options (p. 1).

2. Once you import the file into the application, right-click the Imported Load (External Data) object
and select Create Velocities and Sync Analysis Settings (Beta).
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Once selected, the application automatically:

• Creates an Imported Velocity child object.

• Sets the Mapped Data property to To Binary File and the Specify RPM property to All.

• Synchronizes the Analysis Settings object with the settings of the upstream system.
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Chapter 6: Scoping Substructure Generation Analyses
By default, the Substructure Generation analysis creates one superelement for all active bodies. Now,
when the Beta Options (p. 1) feature is active, the Substructure Definition object provides scoping
properties that enable you to select desired geometry including body selection or body-based Named
Selections. See the example below.

And when you specify a Total Deformation result (the only supported result), the application automat-
ically scopes the result to the specified bodies.

Important:

When using this beta scoping capability, note the following limitations:

• Your Substructure Generation analysis will fail if you have a linked upstream Static
Structural analysis that includes either of the following loads scoped to bodies that
are not included on the scoping of the downstream Substructure Definition object:

– A Pressure load specified with the Define By property set to Normal To or
Vector.

Or...

– A Hydrostatic Pressure load specified with the Define By property is set to
Vector.

You can avoid this issue by applying an equivalent load for either of the above loads
using the Components option of the Define By property. Or you can use a Nodal
Pressure load instead of Pressure/Hydrostatic Pressure.

• In addition, Ansys recommends that you only include Contacts and Joints in the
model to avoid failures for substructure generation.

Example Scoping

Here is an example of a pre-stressed Substructure Generation analysis without beta options active.
All bodies are automatically scoped to the Substructure Definitions object.
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Once you activate the beta options, the ability to scope specific bodies becomes available.

Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.16

Scoping Substructure Generation Analyses



You can then specify a desired body.
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And following the solution, you can export solved substructure for use in another analysis as an Imported
Condensed Part.
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Chapter 7: Fracture
When Beta Options (p. 1) are active, the following features are available for Fracture analyses:

7.1. Crack Meshing - Re-mesh Hex-Dominant Mesh to Tetrahedrons in the Crack Buffer Zone

7.2. SMART Crack Remeshing Controls

7.3. SMART Crack Growth - Mode III Stress Intensity Factor (SIF)

7.4. Saving for Restart Analysis During during SMART Crack Growth

7.1. Crack Meshing - Re-mesh Hex-Dominant Mesh to Tetrahedrons in
the Crack Buffer Zone

When Beta Options (p. 1) are active, the sole property of the Fracture object, Re-Mesh Hex-dominant
to Tetrahedral, provides the following beta options:

• Crack Buffer Zone - MPC Contact (Beta)

• Buffer Zone - Pyramid Elements (Beta)
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These options enable you to convert the hex-dominant base mesh to tetrahedrons within the crack
buffer zone only, instead of converting the entire part associated with the crack’s scoped bodies to
tetrahedrons.

Important:

When you select either of these options, the size of the buffer zone should be large enough
to accommodate the remeshing and crack propagation required for SMART Crack Growth.
However, this size can vary. As needed, use the properties of the Buffer Zone Scale Factor
category in the Details pane to enlarge the buffer zone. In the event your crack grows beyond
the quadratic tetrahedral mesh buffer zone, the application will produce a re-meshing error
during the solution.

Requirements/Limitations/Recommendations

Note the following for mesh conversion within the crack buffer zone:

• These settings apply only when the base mesh of the scoped body is hex-dominant.

• If you include SMART Crack Growth, and during the solution the associated re-meshing reaches
the contact elements created at the crack buffer zone, the re-mesh process for the SMART Crack
Growth could fail. Increasing the size of the buffer zone, through the Buffer Zone Scale Factor
properties, should address the issue.
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• You can use a Body Sizing mesh control specified as a Sphere of Influence to create a finer
mesh around the crack.

• Adaptive mesh refinement is not supported. Set the Use Adaptive Sizing property (Sizing cat-
egory) of the Mesh object to No for a successful crack mesh generation.

Example Usage

Arbitrary Crack

In the following example, the hex dominant base mesh inside of the crack buffer zone of an Arbitrary
Crack is converted to Tetrahedrons using the Buffer Zone - MPC Contact (Beta) option.
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This enables the application to create an MPC bonded contact pair at the interface of the tetrahedrons
and a hex-dominant mesh to hold the elements together during the solution.

Note:

There could be some localized stresses at the buffer zone mesh interface where
contact is created.

The following example illustrates how the Buffer Zone – Pyramid Elements (Beta) setting enables
the application to create pyramid elements at the interface of the tetrahedrons and hex-dominant
mesh to hold the elements together during the solution.

Note:

This option is not supported if the base mesh is a linear mesh.
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Semi-Elliptical Crack

As illustrated for the following Semi-Elliptical Crack, for cracks that support the Hex Dominant
setting for the Mesh Method property, the application creates two contact pairs. The first contact
is at the Fracture Affected Zone (FAZ) interface near the crack and the second contact is at the
crack buffer zone interface.
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When you set the Contact Pairs Nodes property (of the Named Selections Creation category) to
On, the application creates the contact pair target node and contact node components and auto-
matically includes them under the crack object as shown here for the crack mesh and the contact
pairs.
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7.2. SMART Crack Remeshing Controls

When Beta Options (p. 1) are active, the SMART Crack Growth object supports the following
Remeshing Controls category properties:
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DescriptionProperty

The default setting is 0.0 or you can specify a double value.Element Size
For Crack
Front (Beta)

Options include None (default) and Named Selection. When you select Named Selection,
the following additional properties display:

Local Region
(Beta)

• Named Selection (Beta): Use this property to select a desired Named Selection
from the drop-down menu.

• Element Size For Local Region: The default setting is 0.0 or you can specify a
double value.

Options include None (default), Solution Time, Accumulated Max Crack Extension,
and Number of Remeshing Steps. When you select any option other than None, the
following additional properties display:

Increment
Multiplier
(Beta)

• Max Multiplier (Beta): Enter a value greater than 0.

• Start Value (Beta): Enter a value greater than or equal to 0.

• End Value (Beta): Enter a value greater than 0.

7.3. SMART Crack Growth - Mode III Stress Intensity Factor (SIF)

For mixed mode fracture problems, you must include the Mode III stress intensity factor- SIFS (K3), to
calculate the Equivalent SIF Factor (SIF) and Kink Angle. Using beta options, Mechanical supports
certain Equivalent SIF calculation methods. Specify the Equivalent SIF calculation method and related
property definitions/options using the Equivalent SIF Method property of the SMART Crack Growth
object. As illustrated below, the Equivalent SIF Method (Beta) property includes the following options:

• Program Controlled (default): The application uses the Maximum Tangential Stress calculation
method.

• Maximum Tangential Stress: This method does not include Stress Intensity Factor K3 from
Mode III fracture in the Equivalent SIFS calculation.

• Richard Function/Pook Criterion/Empirical Function: These methods consider the Stress In-
tensity Factor K3 from Mode III fracture in the Equivalent SIFS calculation.
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Based on the method you select, define the following additional properties:

• Factor Alpha 1: Displayed when the Equivalent SIF Method (Beta) is set to Richard Function, or
Empirical Function. Specify the positive multiplicative factor for K2 term in the Equivalent Stress
Intensity Factor calculation function. The default value is 1.155. This property can be parameterized.

• Factor Alpha 2: Displayed when the Equivalent SIF Method (Beta) property is set to Richard
Function or Empirical Function. Specify the positive multiplicative factor for K3 term in the
Equivalent Stress Intensity Factor calculation function. The default value is 1. This property can
be parameterized.
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• Kink Angle Method (Beta): Displayed when the Equivalent SIF Method (Beta) property is set
to any option other than Program Controlled. Use this property to specify the method to be
used for kink angle calculation. Options include Maximum Tangential Stress (default) and
Richard Function. This Richard Function option is only supported for when the Equivalent SIF
Method (Beta) property is set to Richard Function or Empirical Function.

• Coefficient A: Displayed when the Kink Angle Method (Beta) property is set to Richard Function.
Specify the coefficient of the first order term in the Richard Function for the kink angle calcula-
tion. The default value is 140°. The valid entry range for this property is -180° to 180°. This
property can be parameterized.

• Coefficient B: Displayed when the Kink Angle Method (Beta) property is set to Richard Function.
Specify the coefficient of the second order term in the Richard Function for the kink angle cal-
culation. The default value is -70°. The valid range for this property is -180° to 180°. This property
can be parameterized.

7.4. Saving for Restart Analysis During during SMART Crack Growth

The beta property, Maximum Total Files to Save (Beta), is available in the Restart Controls category
of the Analysis Settings object. This property displays when the Generate Restart Points property is
set to Manual and Substep property is set to any option other than Last.

This property enables you to specify the maximum total number of restart files that can be saved during
a restart analysis. An entry of 0 specifies the option All. The maximum number of restart files (.xnnn)
that can be saved is 999. The maximum number of remeshing database files (.rdnn) for restart analysis
that includes a SMART Crack Growth object is 99. To specify a value in the Maximum Total Files to
Save (Beta) property, you must set the Maximum Points to Save Per Step to All.

When the specified maximum total number of files is exceeded, the application resets the restart file
numbering back to 1 and continuous to write the restart (.xnnn) and remeshing database (.rdnn)
files. The newest files are retained, and the oldest files are overwritten. The value specified applies to
all subsequent load steps.
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Chapter 8: Merging Contacts with the Same Scoping
When Beta Options (p. 1) are active, the Contact/Connections folder includes the beta property, Merge
Contacts with Same Scoping (Beta). Options include No (default) and Yes. When set to Yes, the ap-
plication automatically merges the already generated/to be generated bonded contacts that have the
same scoping with other contacts, on either contact side or target side, when you select the context
(right-click) menu option Create Automatic Connections.
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Note:

• This feature only works for solid face to solid face contacts.

• You cannot merge contacts scoped to different geometry types like solids and shells.
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Specify the Preference

This property has an associated preference with the same name, Merge Contacts with Same Scoping
(Beta), available in the Connections group of the Options dialog. Preference settings include No (default)
and Yes. Setting the preference to Yes specifies a new default setting for the above property.

Note:

Changing the preference setting automatically updates the default setting of the property,
even in an active session.
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Chapter 9: Incorporating Contact Large Deflection
For large deflection analyses that include a Contact Tool under the Connections folder, this feature
makes sure that the application incorporates large deflection at both the connection and analysis levels
of your simulation.

Note:

As needed, see the Activate Beta Options (p. 1) section to make the feature available.

Insert a Contact Tool from a Connections folder. As shown, the Details category Contact Tool Settings,
and the beta property, Large Deflection, become visible. Options for this property include No (default)
and Yes.

When the Large Deflection property in the Solver Controls of the Analysis Settings is set to Yes when
this property is also set to Yes, the application uses the same program controlled defaults for contacts
results under Contact Tool as the overall analysis (based on the Solver Controls).
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Chapter 10: Resource Prediction Support for Modal
Analysis Iterative Solver
When Beta Options (p. 1) are active, the Resource Prediction feature supports stand-alone Modal
analyses using the Iterative setting for the Solver Type property. You can set the property manually or
it is default selection for the Program Controlled option. This setting enables you to estimate the re-
quired computational time, memory usage, and disk space for the analysis.
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Chapter 11: Disable Optimized File Processing for
External Model Systems
By default, the application organizes and processes data imported from External Data systems using
optimized methods to improve performance when importing Abaqus, LS-DYNA, and Mechanical APDL
files. As desired, you can use beta options to disable this advanced processing capability and instead
use legacy methods.

Note:

This feature does not currently support all source file commands. Some commands may be
skipped.

Activate Beta Key and Option

To make the feature available, you must activate two beta options.

1. On the Workbench Project page, select the Tools menu and then Options. Select the Appear-
ance category, scroll down the dialog, select Beta Options (p. 1), and then select OK. You
need to select Beta Options and then close the dialog for the next options to become available.

2. Open the Tools > Options dialog again and select the Mechanical category. Scroll down the
dialog to the External Model category and select the check box for one or more of the following
options based on file type:
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3. Select OK. As prompted, close and reopen the Ansys® Workbench™ application.

Log File

An associated property is available for these beta options: Enable creation of log file %TEMP% direct-
ory, as shown above. When you enable this option, the application automatically creates a detailed log
file for each command imported into Mechanical as well as any errors that occur.

Limitations

Note the following:

• For Abaqus, only free format files are supported.

• The No Grouping option of the Body Grouping property (Model cell of Mechanical System >
Mesh Conversion Options) is not supported.
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Chapter 12: External Model Browser
The External Model Browser (Beta) tool enables you to view the processed and unprocessed keywords
for LS-DYNA or ABAQUS input files that you import into Mechanical using an External Model system
from Workbench or the Add Model Import option in Mechanical. From the browser tree, you can select
individual keywords and perform actions such as previewing the properties associated with the selected
keyword, adding the keyword to the current analysis (LS-DYNA), or adding a Python snippet (ABAQUS).

Important:

This documentation assumes that you know how to import the above file types. See the
steps to import mesh files from either Workbench or Mechanical in the Attach Geometry/Mesh
section of the Mechanical User’s Guide.

Go to a section topic:

12.1. Displaying the External Model Browser

12.2.Working with LS-DYNA Keywords

12.3.Working with ABAQUS Keywords

12.1. Displaying the External Model Browser

Once you have turned on Beta Options (p. 1) and imported your file, you display the External Model
Browser (Beta) by selecting the:

• Import Summary object and then select the External Model Browser (Beta) option at the bottom
of the page.
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Import Summary Worksheet

• External Model Browser (Beta) option on the Environment Context toolbar.
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Environment Context Toolbar

Here is an example of the browser for a LS-DYNA input file.

Note:

• You can load any input file (LS-DYNA or ABAQUS) using the Browse button for visualization
purposes. However, to perform actions like adding keywords to the current analysis, the
input file must have been imported using an External Model system from Workbench or
the Add Model Import option in Mechanical.

• If a top-level node is selected, the options to insert keywords or command snippet apply
to every keyword under the selected node.

12.2. Working with LS-DYNA Keywords

When importing an LS-DYNA input file, only the unprocessed keywords are shown. You have the option
to add the keyword to the current analysis (or create an LS-DYNA analysis if there isn't one).

To add an unprocessed keyword to the project tree, right-click the keyword and select Add to Analysis.
If there is no LS-DYNA analysis in the project, one is added to the project the first time you try to add
a keyword. The keyword is added using the properties associated with it. Right-click a keyword and
select Properties to see the properties associated with that keyword.
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12.3. Working with ABAQUS Keywords

When importing an ABAQUS file, the External Model Browser will show both processed and unprocessed
keywords. You have the option to generate a Python snippet (Solver Commands object) for any
keywords using the Add Solver Command Snippet option.

To add a keyword to the project, right-click the keyword and select Add Solver Command Snippet. If
there is no analysis in the project, a Static Structural analysis is added to the project. The snippet is
added to the Solver Commands object using the properties associated with the selected keyword. A
new Solver Commands object is created under the current analysis to write these snippets if one
doesn't exist already.
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Additional Options

If the Display Information box is checked, additional information is displayed for the keywords. This
is especially useful to discern between multiple instances of the same keyword.
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Right-click a keyword and select Properties to see the properties associated with that keyword.
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Chapter 13: Improving Harmonic Solutions using Split
Frequencies
When you activate Beta Options (p. 1) for a solved pure acoustic Coupled Field Harmonic, pure
acoustic Harmonic Acoustics, or a Harmonic Response analysis that has the Solution Method property
set to Krylov, the Analysis Settings object provides a new context (right-click) menu option: Split Fre-
quency Range (Beta). This option enables you to achieve a more accurate solution, however, it requires
additional processing time and also creates additional frequency points.
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Go to a section topic:

• Background (p. 50)

• Required Settings (p. 51)

• Application Example (p. 51)

Background

When using the Krylov solution method, the application builds a Krylov Subspace at the middle frequency
of a given range (by default). Therefore, when you evaluate a Krylov Residual Norm Frequency Re-
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sponse result, the result values will be less accurate at frequency points that are farther away from the
Krylov Subspace frequency. That is, the wider the frequency range, the less accurate the result becomes.

To improve accuracy, the Split Frequency Range (Beta) option requires that you specify a frequency
range of not more than 1000 Hz.

Required Settings

In order to make the Split Frequency Range (Beta) option available, you must first specify the following
Analysis Settings properties:

1. Set the Multiple Steps property of the Step Controls category is set to No.

2. Set the Solution Method property is set to Krylov.

3. Set the User Defined Frequencies property is set to On.

4. Specify frequency values in the User Defined Frequencies Steps table in the Tabular Data
window. You must specify a range greater than 1000 Hz.

Application Example

Consider the following example set up:

The user defined frequency range is 2900 Hz. That is, 3000 Hz – 100 Hz..

As illustrated below, once you select the Split Frequency Range (Beta) option, the application will
automatically change the following Analysis Settings:

1. The Multiple Steps property is set to Yes.

2. The Multiple Step Type property is set to Load Step.

51
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.



3. The Number of Steps property is set to the upper bound of the user defined frequency range
divided by 1000 (which is optimal frequency range). In this case, (3000-100)/1000 which is 3.

4. The Step Frequency Range Minimum and Step Frequency Range Maximum properties will
range for only 1000 Hz and their corresponding user defined frequencies. In this example:

• 1st Load Step: The Range Minimum = 100 Hz and the Range Maximum = 1100 Hz. The
User Defined Frequencies = 100,500,800 Hz.

• 2nd Load Step: The Range Minimum = 1200 Hz and the Range Maximum = 2200 Hz.
User Defined Frequencies = 1200,1500,1700 Hz.

• 3rd Load Step: The Range Minimum = 2500 Hz and the Range Maximum: 3500 Hz. User
Defined Frequencies = 2500 and 3000 Hz.
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5.
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Chapter 14: Base Excitations and Loads in a Modal
analysis Scaled in a Linked MSUP System
Using beta options, the application makes existing loads available to Modal analysis systems so that
you can use them to create load vectors and base excitations that you can then make available to a
downstream MSUP system and scale them.

Go to a section topic:

• Overview (p. 55)

• Known Issues and Limitations (p. 56)

• Activate Beta Options and Feature Flag (p. 56)

• Application (p. 57)

• Object Reference - Details Pane Properties (p. 60)

Overview

When beta options are active, you can include the following loading conditions in a Modal analysis,
which are not normally supported:

• Acceleration and Acceleration defined as a Base Excitation

• Displacement defined as a Base Excitation

• Standard Earth Gravity

• Pressure

• Force

The Modal analysis also supports the following additional properties when beta options are active:

• Include Residual Vector: Available in the Options category of the Analysis Settings object.
When set to On the application executes the RESVEC command and calculates residual vectors
for the Modal analysis. The default setting is Off. See the RESVEC command documentation in
the Mechanical APDL Command Reference for additional information.

• Load Control: Available in the Pre-Stress object if you also have an upstream Static Structural
analysis specified for the Modal system. You use this property to define load generation for
prestressed analyses.
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The above options enable you to generate load vectors and base excitations which you can then
transfer to a downstream Mode Superposition (MSUP) analysis, either a Harmonic Response MSUP or
Transient Structural MSUP.

Known Issues and Limitations

Note the following known issues and limitations:

• Having both an unsuppressed Acceleration Base Excitation and a Load Application with Source
property set to an upstream Base excitation under an MSUP environment results in a crash.

• Load vectors generated for modal loads with the Load Vector Assignment property set to
Program Controlled and applied by Surface Effect may be incorrect.

Load Application (Beta) Object

Based on how you configure your upstream system(s), use the beta object, Load Application (Beta),
in your downstream Harmonic Response MSUP or Transient Structural MSUP system to transfer and
scale load vectors and base excitations generated in the upstream Modal analysis.

Activate Beta Options and Feature Flag

This procedure requires you to close the application in order to make the feature available.

1. Active Beta Options (p. 1). Beta Options must be activate in order for the next option to become
available.

2. To activate the feature selection option highlighted below, select the Tools drop-down menu, and
then Options. This displays the dialog shown below. Select the Mechanical option from the tree.
Scroll to the Linear Dynamics group and select Load vector generation in Modal analysis.
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3. As prompted, close and reopen the Ansys® Workbench™ application.

Application

This procedure assumes that you have properly prepared the simulation to the point where you can
now insert the Load Application (Beta) object into a downstream Harmonic Response MSUP or Tran-
sient Structural MSUP analysis. That is, you have properly configured and solved your Modal or pre-
stressed Modal analysis and inserted the desired downstream MSUP analysis.

Tip:

Based on your downstream analysis type, you can use the initial specification object to
automatically generate Load Application (Beta) objects. A Harmonic Response analysis in-
cludes a Modal initial specification object and the Transient Structural analysis includes an
Initial Conditions object which includes a Modal object you use to select the upstream system.
Right-click the associated object and select Transfer Loads form Modal Environment (Beta).
The application automatically creates one Load Application (Beta) object for each base
excitation or load with Program Controlled Load Vector Assignment defined in the upstream
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system as well as one Load Application (Beta) object for each load vector number assigned
to upstream loads for Manual Controlled Load Vector Assignment. See below (p. 60) for
additional information.

To specify a Load Application (Beta) object:

1. Right-click the environment object of the downstream and select Insert > Load Application (Beta).
The application inserts the object.
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2. Specify the Scoping Method property as either Load or Load Vector. Based on your selection,
specify one of the following additional properties:

• Source: Select a desired load from the drop-down list.

• Load Vector Number: Enter the desired load vector number. This value refers to the load
vector numbers specified in the upstream load objects.
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3. Specify the Absolute Result property for base excitation source loads. Options include Yes (default)
and No. Set this property to No if you do not want to include enforced motion.

Important:

If you apply more than one base excitation, the Absolute Result property for each must
have the same setting, either Yes or No.

4. Define the Magnitude property. Magnitude properties for scaling displacement base excitations
have a length unit and scaling acceleration base excitations have acceleration unit. They are other-
wise unitless.

Note:

See the Object Reference - Details Pane Properties (p. 60) topic below for descriptions of
each property available for the Load Application (Beta) object.

Automatically Defined Load Application (Beta) Objects

The application examines each upstream base excitation and load to determine how to define the
properties of the associated downstream Load Application (Beta) object. Note the following:

• For an upstream base excitation, the application automatically sets the Type property of the
downstream Load Application (Beta) object to Base Excitation.

• For an upstream loading condition whose Load Vector Assignment property is set to Program
Controlled, the application automatically sets the Scoping Method property of the downstream
Load Application (Beta) object to Load.

• For an upstream loading condition whose Load Vector Assignment property is set to Manual,
the application automatically sets the Scoping Method property of the downstream Load Ap-
plication (Beta) objects to Load Vector and then assigns the associated Load Vector Number
to the objects.

Important:

If more than one of the loading conditions uses the same load vector number, the
application only creates one Load Application (Beta) object for that particular load
vector number, not multiple objects.

Object Reference - Details Pane Properties

The Details pane for Load Application (Beta) object includes the following properties.
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Property/Options/DescriptionCategory

Scope Mode: Read-only property that describes whether the object is created manually
or using the content (right-click) menu option Transfer Loads from Modal Environment
(Beta) of the initial specification object (described above under the Tip (p. 57)).

Scope

Scoping Method: This property specifies whether the Load Application scales a base
excitation or load defined or load components with the same load vector number. Options
include Load (default) and Load Vector.

Source: Visible when the Scoping Method is set to Load. This field provides a drop-down
list of valid loads included in the upstream Modal analysis. Valid loads include base
excitations and loads with Load Vector Assignment property set to Program Controlled.

Load Vector Number: Visible when the Scoping Method is set to Load Vector. Specify
a load vector associated specified in the upstream load.

Type: Read-only field that describes whether the upstream Source load generated a base
excitation or load vectors when Scoping Method is Load.

Defin-
i-
tion

Absolute Result: For Base Excitation Type only. This option enables you to include enforced
motion with or without base motion. Options include Yes (default) and No.

Magnitude: This property defines the scaling for the upstream loads or base excitations.

• When you set the Scoping Method property to Load Vector, the application scales all
upstream Components that have an assigned load vector number, created either manually
or using the Program Controlled option, that is equal to the value of the Load Vector
Number property of the Load Application (Beta) object.

• When you set the Scoping Method property to Source, the application scales the
non-zero real parts of the load when it is a base excitation, or when you define the load
using one of the following options in the upstream system:

– Vector

– Vector: Real – Imaginary

– Normal To

– Normal To: Real – Imaginary

• Magnitude - Real: Defines the scaling for the non-zero real part of the source load
when it is a base excitation or defined by Vector, Vector: Real - Imaginary, Normal
To, or Normal To: Real - Imaginary in the MSUP Harmonic Response system.

• Magnitude - Imag: Defines the scaling for the non-zero imaginary part of the source
load when it is a base excitation or defined by Vector, Vector: Real - Imaginary, Normal
To, or Normal To: Real - Imaginary in the MSUP Harmonic Response system.

• X Component: Defines the scaling for the non-zero real part of the X Component of
the source load if the load is defined by Components or Components: Real - Imaginary
in the MSUP Transient Structural system.
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Property/Options/DescriptionCategory

• X Component - Real: Defines the scaling for the non-zero real part of the X Component
of the source load if the load is defined by Components or Components: Real - Imaginary
in an MSUP Harmonic Response system.

• X Component - Imag: Defines the scaling for the non-zero imaginary part of the X
Component of the source load if the load is defined by Components or Components:
Real - Imaginary in the MSUP Harmonic Response system.

• Y Component: Defines the scaling for the non-zero real part of the Y Component of
the source load if the load is defined by Components or Components: Real - Imaginary
in the MSUP Transient Structural system.

• Y Component - Real: Defines the scaling for the non-zero real part of the Y Component
of the source load if the load is defined by Components or Components: Real -
Imaginary in the MSUP Harmonic Response system.

• Y Component - Imag: Defines the scaling for the non-zero imaginary part of the Y
Component of the source load if the load is defined by Components or Components:
Real - Imaginary in the MSUP Harmonic Response system.

• Z Component: Defines the scaling for the non-zero real part of the Z Component of
the source load if the load is defined by Components or Components: Real - Imaginary
in the MSUP Transient Structural system.

• Z Component - Real: Defines the scaling for the non-zero real part of the Z Component
of the Source load if the load is defined by Components or Components: Real -
Imaginary in the MSUP Harmonic Response system.

• Z Component - Imag: Defines the scaling for the non-zero imaginary part of the Z
Component of the Source load if the load is defined by Components or Components:
Real - Imaginary in the MSUP Harmonic Response system.

Suppressed: Exclude the object in the analysis. Options include No (default) and Yes.

Step Varying: Options include No (default) and Yes. When you select No, the Load
Application (Beta) object is applicable at all defined steps. When set to Yes, only the load

Step
Con-

step selected in either the RPM Selection or Step Selection properties described below
is applicable.

trols
(Multiple

RPM Selection: This property displays when the Multiple Step Type property is set to
RPM. Select an RPM Selection value from the drop-down menu.

Step
Harmonic
Response

Step Selection: This property displays when the Multiple Step Type property of the
Analysis Settings object is set to Load Step. Specify a Step Selection value from the

Analyses
Only)

values available in the Load Step Value property of the Analysis Settings object to use
for the Load Application (Beta) object.
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Chapter 15: Coupled Field Analyses using Composite
Materials
Now, when you have Beta Options activated, you can link Ansys Composite PrepPost (ACP) systems
to a Coupled Field analysis. See the Basic Workflow section of the ACP User's Guide for the steps to
configure this analysis combination.

Note:

The composite body imported into Mechanical needs to correspond to a Physics Region
that is specified as structural only (Structural property set to Yes).
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Chapter 16: Aeroacoustic Source Imported Loading
Condition
To study sound propagation of aerodynamically generated noise, Mechanical enables you to import an
Aeroacoustic Source loading condition into either a Coupled Field Harmonics or Harmonic Acoustics
analysis system. You create this loading condition in Ansys® Fluent®, and then import it into a supported
downstream Mechanical system, to solve for sound propagation.

Go to a section topic:

• Assumptions (p. 65)

• Activate Beta Options and Feature Flag (p. 65)

• Application (p. 66)

• Source Term Computation in Ansys Fluent (p. 71)

Assumptions

Note the following:

• You must assign the appropriate acoustics material to the bodies of model.

• You are required to create the required source file.

• This feature is only applicable for low Mach number flows.

• There may be modelling errors due to the Lighthill aeroacoustics analogy of splitting the com-
pressible flow variables into the two parts (flow and acoustics) and handling them separately
with the two approximate mathematical models connection through a source term in the wave
equation.

Activate Beta Options and Feature Flag

This procedure requires you to close the application in order to make the feature available.

1. Activate Beta Options (p. 1). You need to select Beta Options and then close the dialog for the
next option to become available.

2. To activate the feature selection option highlighted below, select the Tools drop-down menu, and
then Options. This displays the dialog shown below. Select the Mechanical option from the tree.
Scroll to the Linear Dynamics group and select Aeroacoustic Source Load.

65
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.



3. As prompted, close and reopen the Ansys® Workbench™ application.

Application

This procedure uses a Harmonic Acoustics analysis to illustrated the steps to import an Aeroacoustic
Source loading condition.

1. Right-click the Environment object in the Outline and select Insert > Imported Load > Fluids
Results (Beta).
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2. Using the Result File property, navigate to and select your *.dat.h5 file created Fluent. The
*.cas.h5 file must also be available in the same folder as the *.dat.h5.
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3. Right-click the Imported Load (Fluids Results File (Beta)) object and select Aeroacoustic Source
(Beta).
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4. Select the desired acoustic bodies (only) using the Geometry property and click Apply.
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5. Right-click the Aeroacoustic Source (Beta) object and select Import Load.

6. Complete any additional property specifications. Note that:
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You apply this load using the using the data processing framework (DPF) to generate a
binary file: the Mapped Data property set to To Binary File. See the Load Mapping Workflow
Specification section for the steps to complete any required specifications.

•

• This feature supports source frequency filtering and source frequency interpolation.

• You can specify one or more CFD domains/zones using the CFD Domain property.

• The divergence of the Lighthill tensor (a vector quantity) is transferred from the CFD cell
center to the acoustic finite element node using the Point Cloud algorithm. Therefore, only
the Triangulation and Distance Based Average mapping is supported.

Source Term Computation in Ansys Fluent

Aerodynamically generated noise for low Mach number flows can be predicted using the Lighthill’s
analogy. This offers an efficient alternative for the direct method which is computationally expensive.
Lighthill developed the following wave equation using the continuity and momentum equations of
motions:

Where the Lighthill Tensor ( ) is:

And the variables are:

 = Fluid density.

 = Flow velocity.

 = Destiny at rest.

 = Speed of sound at rest.

 = Lighthill tensor.

 = Reynolds stress tensor.

For low Mach number, incompressible flow, the Lighthill Tensor can be approximated as only the
Reynolds stress term:

The divergence of this Lighthill Tensor also known as Aeroacoustic Source can be applied as the sound
source term to solve for the sound propagation in Harmonic Acoustic wave equation in Mechanical.
The divergence of this Lighthill Tensor can be obtained using the named expressions in Fluent. Then,
a Discrete Fourier Transform is performed to transform the results in the frequency domain. These
transformed results can be written to a Case and Data (extensions?) file that can be imported in to
Mechanical.

See the following sections of the Fluent User’s Guide for more information:
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• Creating and Using Expressions

• Zone-Specific Sampling Options Dialog Box

• Reading and Writing Case and Data Files Together
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Chapter 17: Creating Spot Weld Groups

Prerequisites

This documentation assumes that you understand the concept and use of the application’s existing
Spot Weld feature. The Weld Group (Beta) feature is like the existing Spot Weld control, but has a few
notable differences, including:

• The Spot Weld feature requires a Spot Weld for each weld. The Weld Group (Beta) groups numer-
ous spot welds by the parts/bodies they connect.

• The Spot Weld feature constructs "mesh dependent welds." The Weld Group (Beta) provides an
option to construct the welds as mesh dependent or as mesh independent (as discussed in the
Understanding Mesh Dependent and Mesh Independent Definitions topic).

• The Spot Weld feature requires that you define the spot welds in SpaceClaim or DesignModeler.
Or, that you at least create the spot weld vertices to be used (before entering Mechanical). There
is no current method to create a Spot Weld in Mechanical.

• Currently, you cannot import spot welds defined in SpaceClaim or DesignModeler into Mechan-
ical as a group, however, there is an existing script that imports point locations.

• Activate Beta Options (p. 1) to turn on the feature.

Overview

The Weld Group connection feature (folder) enables you to manage a group of spot welds that connect
multiple surface body parts. This folder provides properties to either import predefined spot welds or
to manually create individual spot welds. An example of an imported group of spot welds is illustrated
below. Once imported, the application automatically creates Weld Connection objects. The data for
the Weld Connection object is displayed in the Details pane. The data for each spot weld is displayed
in the Weld Connection Worksheet. Data includes the source and target bodies of the weld and prop-
erties relating to the set of welds in the Details view and an identifier and a coordinate location for
each spot weld in the Worksheet.

When you select a Weld Connection object, the application highlights the corresponding spot welds
for the given connection in the Geometry window, as illustrated below.
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In addition, the Source body displays in red, the Target body displays in blue, and an orange ball displays
each spot weld. Selecting a row in the Weld Connection Worksheet highlights the individual spot welds
in green.

Understanding Mesh Dependent and Mesh Independent Definitions

The spot welds are assigned a type, either Mesh Dependent or Mesh Independent (default). These settings
are specified by the Weld Type property using the Weld Connection objects. The Weld Type, along with
the setting for Stiffness Behavior determines how the spot welds will be modeled when generating the
mesh.

In the following example, you can see:

• The weld element is modeled the same for mesh dependent and mesh independent weld types.
Using the Stiffness Behavior property, you specify the element as a Flexible (beam), Stiff Beam
or Rigid (beta).
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• For each mesh dependent weld, nodes are inserted during mesh process so that the weld element
connects directly to the shell mesh on the Source and Target bodies. That is, each node of the
weld element is shared with the shell elements.

• For mesh independent welds, the shell mesh and weld elements are generated independently,
and the weld element nodes are not shared with the shell mesh. The Connection Behavior
property controls how the nodes of the weld elements are tied to the shell mesh. Options for
this property include Deformable and Rigid. The connection between the weld elements and
the shells is displayed as a yellow spider web.

MESH INDEPENDENTMESH DEPENDENT

Simply put, for mesh dependent welds, the nodes of the spot weld elements are directly connected to
the shell mesh. For mesh independent welds, the spot weld elements are connected to the shell mesh
either through contact or rigid connections based on property settings.

Spot Weld File Format

Prior to importing your spot weld file, you must ensure that the file you use follows the conventions
used by Dyna or Primer, as shown in this example:

As illustrated, the spot weld files have the following properties:

• Asci file where text is separated by spaces (*.csv type format)

• Each line represents a spot weld, and:

– The first entry should be “SPOTWELD.”

– The second entry is the id of the weld.
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– The third entry is the X position of the weld.

– The fourth entry is the Y position of the weld.

– The fifth entry the Z position of the weld.

– Part identifiers are optional. If part ids are desired, the 6th entry should specify “PARTS” and
then the seventh to nineth entries indicate the parts of the weld.

• If parts are used the part ID in the weld file need to be encoded in the names of the bodies. For
example, if the weld file contains part IDs (54325,54625,54525), the body names would need to
appear as follows, where the body names include the part IDs at the end of the body name.

Weld Thickness

Only two thickness (2T) and three thickness (3T) welds are supported:

Importing Weld Connections

To import Weld Group Connections:

1. Highlight the Connections object and then select the Weld Group option from the Connect group
of the Connections Context tab to insert a Weld Group object. An example of the object’s Details
is show here. Many properties have default values.
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2. Specify highlighted properties. Properties include:

• Material

• Weld Radius

• Length Units

3. Select the entry field of the Weld File Path property and the arrow menu display option. A dialog
opens.

4. Navigate to and select the file you wish to import from the Open dialog.

5. Right-click the Weld Group object and select the Import Spot Welds.
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6. Select each Weld Connection object and review all property definitions as well as the data provided
in the Weld Connection window. Perform corrections as needed.

Manually Creating Weld Group Connections

To create Weld Connections manually:

1. Highlight the Connections object and then select the Weld Group option from the Connect group
of the Connections Context tab to insert a Weld Group object. An example of the object’s Details
is show here. Many properties have default values.

2. Set the Method property to Manual.
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3. Specify highlighted properties. Properties include:

• Material

• Weld Radius

• Length Units

4. Right-click the Weld Group object and select Insert > Weld Connection.

5. Specify the desired surface bodies for the Source and Target properties.

6. Modify object properties as needed.

7. When inserted, the Weld Connection window displays automatically. The Hit Point Coordinate option,
highlighted below, is active by default. This option enables you to set a coordinate location. As show
in the next step, the option displays the exterior coordinates of the model as the cursor is moved
across the model.
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8. Coordinate labels appear where you place the cursor. Select the locations for your spot weld, right-
click, and select the option Create Spot Weld using Hit Point. The data table automatically populates
each coordinates each time a spot weld is specified.

This feature is functional on faces only. It is not functional on edges or line bodies.

9. Continue creating sport welds as desired.

Weld Group Object Properties

The properties of the Weld Group folder specify values for all Weld Connection child objects.

Property/Options/DescriptionsCategory

Method: Specify to import spot weld from a text file or to create them manually.
Options include File Input (default) and Manual.

Definition

Stiffness Behavior: Depending upon the Weld Type setting, select a (element)
stiffness behavior, including:

• Flexible (default)
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Property/Options/DescriptionsCategory

• Stiff beams

• Rigid (beta)

Material: Specify desired material for all (child object) weld connections.

Weld Radius: When the Stiffness Behavior is set to Flexible or Stiff Beam, beam
elements are created during mesh generation. The beams automatically receive a
circular cross section defined for them where the radius is set by this property. In
other words, this Weld Radius is the circular radius representing the weld.

Connection Behavior: This property displays when the Weld Type property is set
to Mesh Independent. The Connection Behavior (for the yellow lines) is defined
as either:

• Deformable (default)

• Rigid

Snap To Edge Tolerance: This property displays when the Weld Type property
is set to Mesh Dependent. The application uses this tolerance (+/-) value during
the meshing process to place or “snap” a weld point to a boundary (edge) as
opposed to placing the weld point on a face that is close to the boundary (closer
than defined tolerance). This helps makes sure that small edges are not created.

Suppressed: Options include Yes or No (default). This property enables you to
remove (and re-include) the object from analysis processes.

Shell Thickness Effect: This property enables you to include the thickness of the
surface body during contact calculations. Instead of contact being detected on the

Advanced

face of the surface body, contact will be detected at a distance that is half the
thickness from the face.

Penetration Tolerance: Specify a desired Penetration Tolerance value.

Angle Tolerance: This property enables you to specify a tolerance (+/-) value that
the desired/ideal orthogonal angle of each spot weld may deviate. The default
value is 30°.

Connections: Total number of Weld Connection objects included in group.Statistics

Weld Points: Total number of spot weld connections included in group.

Weld Connection Object Properties

The properties of the Weld Connection object specify values for the associated grouping of spot welds.

Property/Options/DescriptionsCategory

Source: Display/select the source side surface body for the weld connection. This
geometry can be manually selected or automatically generated.

Scope
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Property/Options/DescriptionsCategory

Target: Display/select the target side surface body for the weld connection. This
element can be manually set or automatically generated.

Method: Specify to import spot weld from a text file or to create them manually.
Options include File Input (default) and Manual.

Definition

Stiffness Behavior: Depending upon the Weld Type setting, select a (element)
stiffness behavior, including:

• Flexible (default)

• Stiff beams

• Rigid (beta)

Material: Specify desired material for all (child object) weld connections.

Weld Radius: When the Stiffness Behavior is set to Flexible or Stiff Beam, beam
elements are created during mesh generation. The beams automatically receive a
circular cross section defined for them where the radius is set by this property. In
other words, this Weld Radius is the circular radius representing the weld.

Connection Behavior: This property displays when the Weld Type property is set
to Mesh Independent. The Connection Behavior (for the yellow lines) is defined
as either:

• Deformable (default)

• Rigid

Snap To Edge Tolerance: This property displays when the Weld Type property
is set to Mesh Dependent. The application uses this tolerance (+/-) value during
the meshing process to place or “snap” a weld point to a boundary (edge) as
opposed to placing the weld point on a face that is close to the boundary (closer
than defined tolerance). This helps makes sure that small edges are not created.

Suppressed: Options include Yes or No (default). This property enables you to
remove (and re-include) the object from analysis processes.

Shell Thickness Effect: This property enables you to include the thickness of the
surface body during contact calculations. Instead of contact being detected on the
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face of the surface body, contact will be detected at a distance that is half the
thickness from the face.

Penetration Tolerance: Specify a desired Penetration Tolerance value.

Angle Tolerance: This property enables you to specify a tolerance (+/-) value that
the desired/ideal orthogonal angle of each spot weld may deviate. The default
value is 30°.

Snap To Edge Tolerance: This property displays when the Weld Type property
is set to Mesh Dependent. The application uses this tolerance (+/-) value during
the meshing process to place or “snap” a weld point to a boundary (edge) as
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Property/Options/DescriptionsCategory

opposed to placing the weld point on a face that is close to the boundary (closer
than defined tolerance). This helps makes sure that small edges are not created.

Weld Points: Total number of spot weld connections for the object.Statistics
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Chapter 18: Specifying Energy Convergence Criteria
For Static Structural and Transient Structural analyses, Mechanical includes a beta feature that enables
you to specify an Energy Convergence criteria property. This new property is available in the Nonlinear
Controls category of the Analysis Settings object. When you include this criterion, the solver requires
fewer iterations to achieve a moderately accurate solution as compared to the Force Convergence
criterion. Property options include:

• Remove (default)

• Program Controlled

• On

When set to On, the following additional properties become available:

• Value: Default value is Calculated By Solver which is equal to an entry of zero (0).

• Tolerance: Default value is 0.5%.

• Minimum Reference: Default value is 1 J.

See the Nonlinear Controls for Steady-State, Static, and Transient Analyses section of the Mechanical
User’s Guide for descriptions of the these properties.

Note:

Like most convergence criteria, all convergence plots include designations where any bisec-
tions, converged substeps, converged steps, or remesh points occur.
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Chapter 19: Creating Local Volume Min/Max Probes
Mechanical includes a beta feature that enables you to display probe labels for the minimum and
maximum result values of all active parts. The application currently includes a feature that enables you
to display min/max probe labels for the results on exterior faces of the model.

Note:

As needed, see the Activate Beta Options (p. 1) section to make the feature available.

Select an evaluated result object, right-click in the Geometry window, and then select one of the fol-
lowing options:

• Create Local Volume Max Probes (Beta): Display probe labels for the largest (Max) result values
within the local range for all active parts.

• Create Local Volume Min Probes (Beta): Display probe labels for the smallest (Min) result values
within the local range for all active parts.

These options support results on the entirety of active parts. Any local min/max value contained in an
active part is detected.
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Chapter 20: Evaluate Gasket Line Pressure Result
When Beta Options (p. 1) are active, you can now create a Gasket Line Pressure result. This result
creates line pressure values for a normalized sealing load acting on a gasket, per unit length. This enables
you to detect fluid leaks across the area of the gasket. This result maps the forces to an ordered array
of points along an imaginary curve at the center line of the gasket. This curve is then presented in
graphical and tabular form.

This result requires a corresponding scoping beta feature: a Construction Geometry Path specified as
an Offset. This path creates multiple quasi parallel curves that you apply to the gasket surface.

Using the defined offset path, that includes user-defined discretization points as well as sub-paths, you
can integrate pressures and determine loading along an imaginary center line of the gasket surface.

Once you evaluate a Gasket Line Pressure result, the application presents the force loads along the
center line as well as the pressures detected along each sub-path.

You can use the Chart feature to compare multiple gasket line pressure results.

Define an Offset Path

In order to create an Offset Path, you must have a circular geometry.

1. Using the Construction Geometry option, Path, specify the Path Type property as Offset.

2. Define the geometries of the path:

a. Under the Reference category of the Details pane, select a desired edge to define the Ref-
erence Geometry property.

b. Under the Offset Guide category of the Details pane, select the interior edge of the body
to define the Offset Geometry property.

3. The application automatically creates sub-paths in between the selected edges using the values of
the Discretization Points (the default setting is 47) and Number of Subpaths (the default setting
is 3) properties. You can change these values as desired.

Define Gasket Line Pressure Result

In order to solve this result, you need to first define loading along the center line of the gasket body.
This can be done by creating a beam and scoping the beam to a Bolt Pretension load.

Specify the result:

1. From the Solution object, open the Gasket drop-down menu and select Gasket Line Pressure
(Beta).
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2. Set the Scoping Method property to Path.

3. Set the Path property to the offset path created above. Make sure that the Geometry property
displays a single body that contains the offset path.

4. Verify a meaningful Display Time property setting. It should not be set to zero.

5. Solve the analysis.

Evaluate Result Values

Here is an example of a Gasket Line Pressure result. Note the available values. The Line Pressure
column displays the force created along the center line and each Value columns present the pressure
values along each sub-path. The Graphics pane displays the force values at each discretization point.
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Chapter 21: Line Chart Options (LS-DYNA Only)
For LS-DYNA analyses, the Line Chart feature has a variety of useful Beta Options (p. 1) that enable
you to create and work with chart data. New context menu options enable you to label and toggle the
display of data included in the chart. In addition, a new Chart Options window includes features to
import additional datasets and perform various operations and apply filters. This pane also provides
options to change the display of your data in the chart and the ability to modify the properties of the
chart axes.
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Got to a section topic:
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• Line Chart Context Menu Options (p. 95)

• Chart Options Window (p. 96)

Also see the Line Chart Results (LS-DYNA Only) section in the Mechanical User's Guide.

Line Chart Context Menu Options

When you specify a Line Chart object, the application displays a graph of the plotted data in the
Worksheet. The graph includes the following context (right-click) menu options:

• Format Chart (Beta): This option opens the Chart Options (Beta) pane.

• Add Label (Beta): Create a label showing the X-Y coordinate of a point selected on the plotted line
of a dataset. You can drag and drop labels anywhere within the chart. Once inserted, right clicking
a label presents the context menu option Delete Label (Beta) in order to remove labels. Also note
that you can drag and drop labels anywhere within the chart.
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Note:

If you change the unit system of your analysis, the application automatically removes all
labels from the chart.

• Delete Dataset: Delete a selected dataset.

• Hide Dataset: Hide a selected dataset. When you hide a dataset, the context menu then includes
the option Show All Datasets. Select this option to redisplay any hidden datasets.

Chart Options Window

The Chart Options window includes the following tabs. All tabs include the Reset All option to reset
your specifications.

Datasets Tab

The Datasets tab provides the following options:

• Import: Browse to and select a new or additional dataset to include in the line chart. The
feature supports importing one dataset at a time.

• Name: Change the default name given to the dataset(s).

• Type: Select the desired display style of the plotted lines and markers used in the chart. You
can change the size, color, and shapes of lines/markers.

Axes Tab

The Axes tab provides the options X Axis and Y Axis. Use these option to:
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• Display grid lines in the chart.

• Display chart data in log10 scale.

• Manually specify the range of the Minimum and/or Maximum values displayed in the chart.

• Edit the labels of either axis displayed on the chart. When you create a line chart in Mechan-
ical, the application applies defaults. When you import datasets, they may already include
X-Y axis labels. Either way, you can specify a new and unique label as desired.

Operations Tab

The Operations tab provides the following options:

Operation

To specify an Operation:

1. Select the Operation option button (also know as radio button) and select the desired Op-
eration from the drop-down menu. Options include:

• Multiplication• None (default)

• Integration • Division

• Scale• Differentiation

• Summation • Offset

•• Flip XYSubtraction

2. Use the Apply To options to select the desired dataset(s) on which to apply the operation.
Options include:

• Current Pick [Name of dataset] (default): Apply the operation to the currently selected
dataset.

• All Datasets: Apply the operation to all of the datasets included in the line chart.

• Multi-select: This option provides a drop-down menu you use to select multiple
datasets.

3. Based on the above selection, use either the Output Dataset Name or Output Dataset
Name Suffix field to name your results.

For the Current Pick option, enter a new name in the Output Dataset Name field or you
can use the application assigned default which is the name of the dataset appended with
the name of the operation in parentheses.

To name the results of operations using the All Datasets or Multi-select options, enter your
desired string in the Output Dataset Name Suffix field. The application appends this string
to each affected dataset's name. If the operation produces a single output, such as the
summation of multiple datasets, the application uses your string as the name of the resulting
dataset.
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4. Once you have completed defining the operation, select the Apply button. The application
plots the new dataset on the chart. The application performs the computation on the y-axis
for all datasets you have selected in the chart. Each operation uses the x-axis of the first
dataset as reference. Other datasets are linearly interpolated.

Note:

Input for the operations can differ. Certain operations require at least one
dataset, while others, such as subtraction and division, must have exactly two
datasets as input.

Output for the operations may also differ. Certain operations, such as multi-
plication, can accommodate more than one dataset as input, but it returns
only a single dataset as a result. Whereas other operations produce one output
for each associated dataset.

Note:

When using the Division operation, there are instances when it divides by zero
(0) and fails to generate a new dataset.

Filter

To specify a Filter:

1. Select the Filter option button (also know as radio button).

2. Select the desired Filter option from the drop-down menu. Options include:

• None (default): Reset any previous filters and redisplay the plot of the original dataset.

• Butterworth: Apply a Butterworth filter to create and plot a new dataset.

• Butterworth LSPP: Apply a Butterworth LSPP filter to create and plot a new dataset.

• SAE: Apply a SAE filter to create and plot a new dataset.

3. When you specify a Filter type option, the Cutoff Frequency (Hz) property also displays.
Use this property to define a cutoff frequency value for the applied filter. The default setting
is 0.1.

4. Use the Apply To options to select the desired dataset(s) on which to apply the filter. Options
include:

• Current Pick [Name of dataset] (default): Apply the operation to the currently selected
dataset.

• All Datasets: Apply the operation to all of the datasets included in the line chart.

• Multi-select: This option provides a drop-down menu you use to select multiple
datasets.
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5. Based on the above selection, use either the Output Dataset Name or Output Dataset
Name Suffix field to name your results.

For the Current Pick option, enter a new name in the Output Dataset Name field or you
can use the application assigned default which is the name of the dataset appended with
the name of the filter in parentheses.

To name the results of a filter using the All Datasets or Multi-select options, enter your
desired string in the Output Dataset Name Suffix field. The application appends this string
to each affected dataset's name.

6. Once you have completed defining the filter, select the Apply button.
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Chapter 22: Animating Results in Multiple Viewports
If you are using a Windows system that supports OpenGL 4.3, and the Beta Option is turned on, you
can animate (multiple) results in multiple Viewports. The Viewports feature enables you to split the
Geometry window into multiple windows, up to four, and select independent result objects in each
window.

Note:

The results you select must support Accelerated Animation.

Note:

As needed, see the Activate Beta Options (p. 1) section to make the feature available.

Once you have displayed your evaluated results in multiple viewports, select the Multi-Viewport An-
imation option on the Animation toolbar to begin the animation.

Here is an example of the feature in use.
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Chapter 23: Fetching an RSM Result

Summary

Currently, when you are 1) performing a multistep solution, 2) using the Mechanical APDL Solver, 3)
using the Remote Solve Manager (RSM), there is a beta option that enables you to retrieve load step-
based results during the solution process.

Once you have properly configured your remote resource using the RSM Configuration Application,
enabled the Remote Post feature, queued your solution in Mechanical (and waited for it to start), the
Solution object provides the context (right-click) menu option: Fetch Remote Results (illustrated below).
This option enables you to display result content for the most recently completed load step while the
solution is running.
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Compatibility Requirements

Review the following compatibility requirements for the use of this feature. The Remote Post system:

• Requires enabling the beta key and feature flag prior to starting a solution (see next section).

• Will only work on cluster setups that support the IBM Platform MPI for inter-node communication.

• Does not encrypt or authenticate internal data connections. May not be appropriate for use on
unsecured networks.

• Selects a random port when initiating a connection between the server and Mechanical. Network
firewalls that block certain ports may interfere with functionality.

• Does not support Probes or Toolbox results.

Activate Beta Key and Option

Activate this feature from the Command Prompt. At the command prompt, type RunWB2.exe and
include the '-k Mechanical.RemotePostRSM' argument. This turns on the feature flag and opens
the Workbench application.

On the Workbench Project page, select the Tools menu and then Options. Select the Appearance
category, scroll down the dialog, select Beta Options, and select OK.
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Chapter 24: Explicit Dynamics Blast Analysis in
Mechanical
An initial prototype exposing the Autodyn blast analysis functionality in the Explicit Dynamics analysis
system is available through the EXD Euler Enhancements beta feature flag. To set this flag in Workbench,
open the Tools → Options dialog. Check the box next to the option in the Mechanical tab.

The functionality exposed under this beta feature for release 2025 R1 is as follows:

• Two different domain types for 2D Euler analyses:

– 1D wedge domain for performing a 1D blast

– 2D grid domain

• Exposure of the Detonation Point in 2D

• Output of data files (with file extension .fil) of the results of a 2D axisymmetric MME analysis to
be used for remapping into a 3D MME analysis
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• Remapping from a 2D data file (extension .fil) into a 3D MME analysis in Mechanical exposed via
an ACT extension

For more information about the above functionality and EulerRemap object limitations, see the following
sections:

24.1. Domain Types for 2D Multi Material Euler Solver

24.2. Guidance on Setting up a 1D Wedge Analysis in Mechanical

24.3. Using the Euler Remap ACT Extension

24.4. Limitations

24.1. Domain Types for 2D Multi Material Euler Solver

The 2D Multi Material Euler (MME) solver from the Ansys Autodyn solver has been exposed in the
Mechanical interface. Two domain types can be created:

• A wedge for performing 1D blast analyses

• A grid (box) for performing 2D MME analyses

The domain type is determined by the Euler Domain Controls in the analysis settings.

If the Domain Type is set to Wedge, the virtual MME domain created is a 1D wedge. For how to set
up a 1D wedge analysis, see Guidance on Setting up a 1D Wedge Analysis in Mechanical (p. 109).
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If the Domain Type is set to Grid, the default virtual MME behaviour is activated: the virtual MME domain
created is a box and the controls work the same as for 3D virtual Euler MME domains with full Euler-
Lagrange coupling turned on in the Explicit Dynamics solver.

The option to output data files containing the information needed to remap the results from a 2D
axisymmetric MME domain into a subsequent analysis has been added to the Output Controls. The
option is Output Remap File and can be set to Off, On or Program Controlled. If set to Off, no data
files will be produced. If set to On, data files will be produced containing the data from any 2D MME
domains, at the same frequency as the results files. If set to Program Controlled, the data files will be
produced if there is a virtual MME domain of type Wedge, but will not be produced if there is no virtual
MME domain or if there is a virtual domain of type Grid.

The file name of the data files is of the form remap_{cycle}.fil, where {cycle} is the cycle number
at which the data file was produced. The data files can be used to initialize an 3D MME analysis in
Mechanical using the provided ACT extension (see Using the Euler Remap ACT Extension (p. 111)). They
are also of the correct file format to be used to fill Multi Material Euler and Euler Ideal Gas parts in the
Autodyn Component System.

24.2. Guidance on Setting up a 1D Wedge Analysis in Mechanical

First create an Explicit Dynamics system in the Workbench Project Schematic. Open the Properties for
the Geometry cell and set the Analysis Type under Advanced Geometry Options to 2D, and create
or import an appropriate geometry. For simple 1D wedge analyses consisting of a sphere of explosive
surrounded by the ambient material, a sample geometry has been provided with in
%AWP_ROOT212%\aisol \Samples\AUTODYN. To use the sample geometry, import the file
1D_wedge_geometry_for_blast.agdb. To change the radius of the explosive material, or the
blast radius, modify the parameters ExplosiveMaterialRadius or BlastRadius in DesignModeler.

If you need to create your own geometry, it is important to understand that the geometry of the virtual
MME wedge domain that will be created in the Explicit Dynamics solver. This is because the created
bodies designed to fill this virtual MME domain must cover the virtual MME domain completely (else
there will be void regions).

The wedge domain created in the solver will begin at the global origin and will run along the axis of
symmetry (see the following note (p. 109)). The wedge has an angle of 10 degrees. The bodies with
Reference Frame set to Eulerian (Virtual) must cover this region in space. An example of an appropriate
geometry is shown in Figure 24.1: Appropriate Geometry for a 1D Wedge Analysis (p. 110).

Note:

For users familiar with the Autodyn user interface, in Autodyn 2D axisymmetric models, the
axis of symmetry lies along the global X-axis. This is contrary to 2D axisymmetric models in
Mechanical, where the axis of symmetry lies along the global Y-axis. Therefore, all Explicit
Dynamics 2D axisymmetric models created in Mechanical must be set up assuming the axis
of symmetry is along the global Y-axis. This is appropriately handled in the Explicit Dynamics
solver by performing a coordinate transformation so that the axis of symmetry is mapped
onto the global X-axis.
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Figure 24.1: Appropriate Geometry for a 1D Wedge Analysis

The geometry that makes up the wedge consists of two bodies: one to model the explosive (the smaller
green colored body), and the other to model the ambient material in which the explosion is taking
place (the larger brown colored body). Be sure that these two bodies do not overlap; otherwise the fill
into the Eulerian domain may not be as expected. The coordinate system displayed is the Global Co-
ordinate System. Note how the wedge is aligned with the global Y axis, and that the two bodies together
effectively form a sector of a circle centered at the global origin with a 10 degree angle at the center
of the sector. The shape shown here will also be the shape of the MME domain.

Once the geometry has been created or imported, the remainder of the model can be set up in Mech-
anical.

1. For a 1D wedge analysis, the 2D Behavior of the Geometry must be set to axisymmetric. The bodies
need to have the Reference Frame set to Eulerian (Virtual).

2. You should delete all objects under the Connections folder, including Contact Regions and Body
Interaction objects, since the analysis will be purely Eulerian.

3. Generate the mesh. The default mesh settings should be sufficient.

4. Insert a Detonation Point at X = 0, Y = 0.

5. Set the Analysis Settings:
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• Step Controls:

– Time Step Safety Factor = 0.6666.

• Solver Controls:

– Detonation Burn Type = Program Controlled (for 2D analyses, this defaults to Direct) or Direct.

• Euler Domain Controls:

– Domain Type = Wedge.

– Minimum Y Coordinate = 0. M.

– Y Dimension - set to blast radius.

– Total Cells - set the total number of cells along the wedge. The resulting cell size will be the
Y Dimension divided by the Total Cells. Note that the more cells, the more accurate the simula-
tion, but the longer the run-time. It is recommended that the cell size is such that there are at
least 10 cells across the radius of the explosive material.

Note:

No grading of the mesh has been exposed at release 2025 R1. This is being considered
for a future release.

• Output Controls:

– Output Remap File – Set this to Program Controlled or On to trigger the output of data files
(.fil file format) to be used to remap the solution into a 3D analysis. The frequency of the
data files produced is the same frequency as the result file output. The files produced are named
remap_{cycle}.fil, where cycle is the cycle number that the data file is produced.

You can set Output Remap Files to On for other Eulerian domain types if the 2D Behavior is
set to Axisymmetric - otherwise no remap files will be output (Program Controlled regulates
this behavior as well).

If there are no Euler domains present in the model, setting Output Remap Files to On is ignored
(a warning message is generated).

Prior to using any generated data files for remapping, you should inspect the results in order to ensure
that the blast wave has not reached the extents of the wedge at the cycle where the results will be
transferred during the remapping. This can be done by inserting User Defined results for variables such
as PRESSURE or INT_ENERGYALL, or by adding Pressure or Energy trackers.

24.3. Using the Euler Remap ACT Extension

The Euler Remap ACT Extension included with the standard Ansys installation provides a means to
remap results produced in a 1D wedge blast analysis into a 3D analysis containing an Euler Multi Mater-
ial virtual domain in an Explicit Dynamics analysis in Mechanical. The extension can only be used when
the EXD Euler Enhancements beta feature flag is switched on.
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The EulerRemap extension must be loaded before it can be used. Select Extensions → Manage Exten-
sions... in Workbench and select the check box next to the extension to load it. Then add a 3D Explicit
Dynamics system to the project and create or import your geometry, and define the materials used in
Engineering Data. Once the extension is loaded and the materials and geometry have been fully defined,
the extension is ready to be used in Mechanical.

Note:

The extension will currently only work for 3D analyses.

To remap the data from a data file (.fil file), set up the analysis so that a virtual Euler domain will be
created. Then right-click the Explicit Dynamics system in the Project and insert an EulerRemap object.
The EulerRemap object has the following fields:

• Remap FileName – Choose the data file to use for the remapping. The data file could be from a 2D
MME analysis performed in an Explicit Dynamics system, or from an analysis performed in an Autodyn
component system.

• Remap Center X/Y/Z-Coordinate – Enter the coordinates in the 3D analysis where the origin of the
2D analysis should be mapped.

• Symmetry Axis Direction – Choose which axis in the 3D model aligns to the axis of symmetry from
the 2D axisymmetric analysis.

• Ignore Missing Materials?

– Yes – Any materials that are in the data file that do not exists in the 3D model (meaning, they are
not defined under the Materials object in Mechanical and they are also not assigned to a body)
will not be remapped.

– No – If there are any materials in the data file that do not exist in the 3D model (meaning, they
are not defined under the Materials object in Mechanical and they are not assigned to a body),
the 3D model will issue an error message and will not run.

• Generate parts for missing materials?

– Yes – If any materials defined under the Materials object in the 3D analysis are not assigned to a
body in Mechanical, the extension will automatically create a construction geometry part for that
material. See the notes (p. 113) on automatically generated parts.

– No – Do not automatically generate parts for missing materials. See the notes (p. 113) on automat-
ically generated parts.
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Notes on Automatically Generated Parts

When Generate parts for missing materials? is set to Yes, construction geometry parts are created
for existing materials in the project that are not assigned to a body. This ensures that these materials
can be successfully remapped into the 3D model, allowing them to be post-processed in the 3D model
in Mechanical. The autogenerated parts are created when you click Solve. Each part created is a cube
located at the remap center. The dimensions of the cube are chosen such that the part should have no
impact on the results of the analysis.

The parts are created using Construction Geometry Solids and are given a name of the format AutoGen-
erated_DummyBody_{material_name}, where {material_name} is the name of the material for which the
dummy part is created. The parts created from the construction geometry solid are set to Eulerian
(Virtual). Additionally, a Named Selection for each dummy part is created to assist with the scoping of
results to these parts for Post Processing.

24.4. Limitations

• EulerRemap object limitations:

– Only one EulerRemap object is permitted per analysis

– The object can be used in 3D analyses only

• Any objects generated by the EulerRemap object at solve time (for instance auto generated parts)
do not get deleted when you use Clear Generated Data.
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Chapter 25: Virtual Eulerian Surface Bodies
An initial prototype, which exposes the use of (Virtual) Eulerian surface bodies in the Explicit Dynamics
analysis system, is available through the Euler Enhancements beta feature flag. To set up this flag in
Workbench, follow these steps:

1. Open the Tools > Options dialog.

2. Check the box next to the option in the Mechanical tab.

• Two different (Virtual) Eulerian surface body options are supported for mapping material and
initial conditions into 3D Euler:

– Volume filling of the Eulerian domain, using closed single connected surface bodies

– Directional filling of the Eulerian domain, using surface bodies with a defined filling direc-
tion

Mapping of Surface Bodies with Euler Reference Frame to Virtual Euler Domain

115
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.



• The standard mesh, which is generated on surface bodies marked with Eulerian (virtual) reference
frame, is only used to represent the geometry of the surface body during initialization of the model
for the solver. The material and initial conditions defined on surface bodies, which are marked as an
Eulerian reference frame, are mapped to the Euler domain. The mesh associated with the original
surface body is then deleted, prior to the solve. A unique material is created for each surface body
that is mapped into the Euler domain for post processing.

• If multiple solid and surface bodies marked as Eulerian overlap, the body higher in the Outline view
will take precedence. Therefore, the material assigned to the region of overlap will correspond with
the material assigned to the first Eulerian body.

For more information about the Eulerian surface body options and the limitations, see the following
sections:

25.1. Closed Single Connected Euler Surface Bodies

25.2. Single Connected Euler Surface Bodies with Filling Direction

25.3. Limitations

25.1. Closed Single Connected Euler Surface Bodies

The domain of the 3D Multi Material Euler (MME) solver can be filled with material and initial conditions
using a closed single connected surface body. The interior of the closed surface body inside the Eulerian
domain will be filled with the material and initial conditions of that surface body.

A surface body is defined as a 3D (virtual) Euler body, when the Reference Frame of that surface body
is switched in the Geometry setting from Lagrange to Eulerian (Virtual).
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Not only does this definition trigger the creation of the virtual MME domain, but the interior volume
of the closed surface body is used to fill the virtual MME domain with the material and initial condition
assigned to it.

The surface must be single connected. This means that the surface consists of faces which only
connect a maximum of two faces along their edges, and no T-joints or multiple joints are allowed.

Note:

The thickness of the Eulerian surface body is not taken into account to compute the internal
filling volume. However, it needs to have a non-zero thickness value assigned.

25.1.1. Closed Single Connected Euler Surface Bodies with Holes or Openings

The closed single connected surface, that is used to map material and initial conditions into the MME
domain, may contain holes or openings. The mapping algorithm will generate a completely closed
Euler surface body by closing the holes and openings with triangular elements. The triangular elements
are generated from the nodes along the edge of a hole or opening and a central node in the middle
of the hole or opening, that has the average x-, y-, and z-coordinate of all nodes along the edges of
the hole or opening.

Figure 25.1: Example of (a) Euler Surface with Holes and Openings, (b) Closing of Holes and
Openings in Euler Surface, and (c) Resulting Material Mapping into MME Euler Domain

25.2. Single Connected Euler Surface Bodies with Filling Direction

The domain of the 3D Multi Material Euler (MME) solver can be filled with material and initial conditions
using a single connected surface body in combination with a filling direction. The filling direction is
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defined by the direction of the z-axis of a local coordinate system, which is scoped to the Eulerian filling
surface. To be used as a filling coordinate system, the origin of the local coordinate system should not
coincide with the origin of the global coordinate system.

The extruded volume of the Euler surface body in the z-direction of the selected local coordinate system
inside the 3D Multi Material Euler (MME) domain will be filled with the material and initial conditions
of the surface body.

The extruded volume will extend to the boundary planes of the 3D Multi Material Euler (MME) domain.
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Figure 25.2: Example of (a) Euler Surface Body with Defined Filling Direction , (b) Location of
Euler Surface Body in MME Euler Domain, and (c) Resulting Material Mapping into MME Euler
Domain

25.3. Limitations

• The following are some Euler surface body limitations:

– Eulerian surface bodies are used in 3D analyses only.

– Eulerian surface bodies are deleted after mapping of the material and initial conditions to the Euler
MME domain, and are not available for structural analysis.
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Chapter 26: Command Objects for SPH Settings
These beta command objects are available as an option to control the solution settings for the SPH
solver in Explicit Dynamics analyses. Although the default options are usually sufficient for many applic-
ations, these command objects may be used to overcome any numerical problems exhibited by an
analysis, such as tensile instability. For further information, see Command Objects in Explicit Dynamics.

To access the command objects, turn on Beta in the Workbench options.

Calculate the density using the continuity
equation (Default)

SPHSETTINGS,DENSITYCALC,CONTINUITYEQ

Calculate the density using a kernel sumSPHSETTINGS,DENSITYCALC,KERNELSUM

Use a constant smoothing length (Default)SPHSETTINGS,SMOOTHINGLENGTH,CONSTANT

Use a variable smoothing lengthSPHSETTINGS,SMOOTHINGLENGTH,VARIABLE

Use the cubic B-spline as the weighting
function (Default)

SPHSETTINGS,SMOOTHINGFUNCTION,CUBICSPLINE

Use a quintic spline as the weighting
function

SPHSETTINGS,SMOOTHINGFUNCTION,QUINTICSPLINE

Use the Monaghan type artificial viscosity
(Default)

SPHSETTINGS,VISCOSITYOPTION,SPHWITHSHEARCORRECTION

Use the Neumann and Richtmyer artificial
viscosity

SPHSETTINGS,VISCOSITYOPTION,STANDARD

Density Calculation

Two alternative methods for calculating density have been implemented—the continuity equation is
the default method. Calculating the density by kernel sum is activated using the beta command object
shown in the table above. The default option is the most common found in the literature, and it works
well for a wide range of applications. However, under certain circumstances, inconsistencies in the SPH
equations may result in negative densities and numerical issues. In such cases, the density calculation
by kernel sum may overcome such problems.

Variable Smoothing

The accuracy and robustness of the SPH processor depends on the quality (in particular, the number)
of the local neighboring particles. In expansive flow of material, the distance between SPH particles
increases. If this distance exceeds twice the smoothing length of the particles, the two particles will no
longer interact. This loss of interaction may be unphysical and is commonly described as 'numerical
fracture'.

In an attempt to reduce the problem of numerical fracture, an option to add a variable smoothing
length has been included as a beta functionality, which can be activated by a command object. When
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activated, as particles separate and their density decreases, their smoothing length increases so that
interaction with neighboring particles is maintained.

Since changes in the smoothing length result from changes in density, the variable smoothing option
works well for isotropic flows. However, for many continuum dynamics applications, anisotropic flow
is observed. For example, in plastic flow of metals, the volume (hence density) is almost constant while
the deformations are grossly anisotropic. The current implementation of variable smoothing does not
work well in such situations and numerical fracture is often unavoidable.

SPH Artificial Viscosity

There are two types of artificial viscosity available for the SPH solver. The default option is the Monaghan-
type artificial viscosity, which is described in Damping Controls. This is the recommended formulation
to use. The Neumann and Richtmyer form of artificial viscosity is the second option. Refer to the table
above to use the respective command objects.
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Chapter 27: Export Material Calibration Results as
New or Updated Materials in Mechanical
A beta feature allows you to save material calibration results as new materials when you run the Ansys
Material Calibration App from within Mechanical.

Use the Ansys Material Calibration App to calibrate your test data against a material model. You can
then export the results directly into your model as a new material, merge properties that were recorded
under different temperatures, or replace the properties of an existing material with calibration results.
This skips the step of accessing the Engineering Data workspace to add or update a material in your
model.

Note:

As needed, see the Activate Beta Options (p. 1) section to make the feature available.

Export Material Calibration Results as New or Updated Materials

To calibrate a material from within Mechanical and export the results:

1. Click the Material Calibration App icon  on the Materials context menu or right-
click the Materials object and select Material Calibration App from the menu.

The application launches in a separate browser window as shown below.
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2. Follow the steps in the ANSYS Material Calibration Guide (Standalone) to load your test data into
the Material Calibration application and calibrate the data against a material model.

3. When the calibration is finished, click the Export icon . The Export settings window displays
as shown below. The names of the calibrated material models are shown under Models.
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4. Select the material model(s) to export and click OK.

Warning:

The Ansys Material Calibration App and Mechanical do not check whether exported
calibration results contain mutually exclusive (or redundant) material models. Assigning
a material with mutually exclusive material models can cause the solution to fail. This
is especially a problem if you select multiple hyperelastic material models when you
are exporting material calibration results.

To avoid this problem, review the selected material models before you export them.
Only export valid combinations of material models to the same material. See Valid Ma-
terial Model Combinations for a list.

5. Choose how to export the results of your material calibration:

• To save the calibration results as a new material, follow the steps in Save Exported Material Cal-
ibration Results as a New Material (p. 126).

• To merge the calibration results with the properties of an existing material, follow the steps in
Merge Material Calibration Results (p. 126).
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• To replace the properties of an existing material with the calibration results, follow the steps in
Overwrite Target Material with Material Calibration Results (p. 127).

After the export process finishes, you can assign the new or updated material to objects in your model.

Save Exported Material Calibration Results as a New Material

Use Create New Material to export material calibration results as a new material:

1. In the Export settings window, select Create New Material from the Materials drop-down menu.

2. Enter the name of the new material in the Material Name field.

3. Click OK.

The exported calibration results are saved as a new material. It is listed under the Materials object in
the Outline pane of the model. You can view the properties of the new material in the Engineering
Data Material View window.

Merge Material Calibration Results

Some materials exhibit different properties under different physical conditions. For example, the prop-
erties of a material can vary according to temperature. To model these materials, measure their properties
under different physical conditions and use the Ansys Material Calibration App to compute material
properties from the test results. Use Merge to combine the exported properties with those of the target
material. This stores the material properties that you calibrated for the different physical conditions
under test.

How Merge Affects the Properties of the Target Material

• You can merge multiple exported material models with the target material.

• If you select a material model that is not contained in the target material, the Material Calibration
application appends the calibration results to the target material. (This applies regardless of temper-
ature.)

• If you select a material model that is contained in the target material and was calibrated at the same
temperature, the Material Calibration application overwrites the target material model's properties
with the exported calibration results.

• If you select a material model that is contained in the target material but was calibrated at a different
temperature, the Material Calibration application appends the exported calibration results to the
target material.

Merging Exported Material Calibration Results

To merge material calibration results with the properties of an existing material:

1. In the Export settings window, select the name of the material from the Materials drop-down
menu.

2. Select Merge from the Import Options drop-down menu.
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The exported calibration results are merged with the properties of the selected material as described
earlier in this section. You can view the merged material properties in the Engineering Data Material
View window.

Overwrite Target Material with Material Calibration Results

Use Overwrite to completely replace the properties of an existing material with the exported material
calibration results.

1. In the Export settings window, select the name of the target material from the Materials drop-
down menu.

2. Select Overwrite from the Import Options drop-down menu.

All of the properties of the target material are replaced by the exported calibration results. You can
view the updated properties of the material in the Engineering Data Material View window.
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Chapter 28: TPA Workflow for FRF Calculator

Summary

A Transfer Path Analysis (TPA) workflow is available from the FRF Calculator in the NVH Toolkit, offering
functions and properties as described below.

The following options are available under the FRF Calculator Details.

Start TPA Workflow

Binary property to start the TPA workflow.

Component Type

Binary property to select Active/Passive. Exposed if the Start TPA Workflow property is enabled.

Input Degrees of Freedom

Input the preferred DOFs as a comma-separated string of text (such as fx,fy,fz,mx,my,mz).
This option is only available when using the Start TPA Workflow option with the Component Type
set to Active.

Nodes Definition

If Start TPA Workflow is set to Yes, Nodes Definition will be set read-only to Named Selections.
When the Component Type is set to Active, the Input Nodes and Grouped Named Selection
Connectivity Nodes properties will be shown. When the Component Type is set to Passive, the
Output Nodes and Grouped Named Selection Connectivity Nodes properties will be shown.

Grouped Named Selection Connectivity Nodes

Group of Nodal Named Selections that defines the Connectivity Nodes of the FRF Worksheet. Only
one Named Selection is allowed.

If the Start TPA Workflow property is selected, once the FRF Worksheet table is filled, all the columns
will be read-only except for the Name column. If you have selected an Active component, Output
Node and Output DOF change to Connectivity Node and Connectivity DOF respectively. If you have
selected a Passive component, Input Node and Input DOF change to Connectivity Node and Con-
nectivity DOF.

Additionally, If you have selected the Start TPA Workflow property, you can only export displacement
data from the FRF Plotter to an h5 file, which will be the input for the TPA Calculator.
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Chapter 29: FRF Curve Fitting Analysis
You can use the NVH Add-on to perform Curve-Fitting analysis to extract natural frequencies and
damping from UNV model FRF data.

The following options are available under FRF Calculator Details.

Curve-Fitting Options

Start Curve-Fitting Workflow

Binary property used to start the Curve-Fitting workflow. If enabled, it makes changes in the FRF
Worksheet and the Stabilization Chart (p. 132) is displayed. Only available when the unv file has
been loaded.

Range Minimum

The lower bound of the frequency range where Curve-Fitting is calculated.

Frequency Maximum

The upper bound of the frequency range where Curve-Fitting is calculated.

Maximum Modal Polynomial Order

The maximum order of the polynomial you wish to reach in the Curve-Fitting analysis.

If the Start Curve-Fitting Workflow property has been enabled, the FRF Frequency Table is hidden in
the FRF Worksheet and will be shown, along with the associated buttons, in the Stabilization Chart (p. 132).

29.1. Curve-Fitting Methodology

Once the UNV data has been loaded in the FRF Calculator, you can perform Curve-Fitting Analysis
based on a least-squares complex frequency estimation. Multiple input FRFs are summed and the obtained
FRF is then used.

As a first step, the frequency range of interest is selected and input data is converted to the z-domain.
To do this, a P Matrix is created and the measured FRF is scaled using this matrix, obtaining a T Matrix.
The ratio of T/P is aligned with the FRF of the system which is approximated as A/B.

The derivatives of the error with respect to each polynomial coefficient give the system of equations,
which can be solved using a least-square method.

131
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.



The normal equations are then combined and the contribution of the numerator coefficients (A) and
denominator coefficients (B) are individually solved.

Poles can be obtained from the coefficients using the eigenvalues of the companion matrix. The eigen-
values are then converted from the z-domain to the problem domain. Stable poles are filtered based
on whether the real value of the pole is negative.

Poles can be converted to natural frequencies by taking the absolute value, while the damping is the
negative ratio of the real part of the poles to the natural frequency.

The analysis is solved for a range of orders, and the stability of the frequencies and the damping are
checked in the Stabilization Chart (p. 132). Once the order has been established, the synthetic FRF can
be obtained as:

where:

 = the r natural frequency

 = the r damping value

 = the angular frequency

 = the residue, which is the product of the mode shape and the mode participation factor.

This first term is the contribution from the modes in the selected frequency range.

 = (Lower Residual) a coefficient to account for correction of frequencies lower than those
in our analysis

 = (Upper Residual) a coefficient to account for correction of frequencies higher than those
in our analysis

29.2. Stabilization Chart

The Stabilization Chart displays the information from the Curve-Fitting analysis. After generating the
analysis, this will show the sum of the test FRFs selected from the FRF Worksheet, as well as the inform-
ation regarding the stability of the poles. Once the modal order has been set and the Extract Curve-
Fitting parameters data option selected, this information will be provided in the second Frequency
Table, and the synthesized FRF will be shown in the plot. Selecting the modes will update this synthesized
FRF dynamically, based on the modes selected.

The Stabilization Chart is divided into three parts:
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Stabilization Plot

A dynamic plot that allows hovering, zooming and panning operations. This plot is dynamically
updated using the Stabilization Chart Options and the second Frequency Table, which
contains Curve-Fitting stable modes. The maximum and minimum frequency values of the x-
axis are restricted to those defined in the Curve-Fitting section of the FRF Calculator Details.

The entire data range can be plotted by selecting the Autoscale option. Clicking the Home
icon (reset axes) replots the data in the user-defined frequency range.

If the Extract Curve-Fitting parameters data option has not been selected, the plot will only
show the test FRF and the stability of the poles. Otherwise, it will also show the FRF estimation
of the Modal Order selected in the Stabilization Chart Options, with the modes selected in
the second Frequency Table.

Stabilization Chart Options

The modal orders are increased from a low to a high value and the stability of generated modes
can be studied visually. Depending on the threshold set, the modes identified at each order
are tagged with one of the following:

• o : Newly detected mode

• f : Only frequency stable

• d : Only damping stable
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• s : Both frequency and damping stable

The following properties are available:

Frequency Tolerance (%)

Allows you to change the frequency tolerance to consider a pole to be stable based
on its frequency, compared to the previous iteration. This updates the plot dynamically.

Damping Tolerance (%)

Allows you to change the damping tolerance to consider a pole to be stable based on
its damping value, compared to the previous iteration. This updates the plot dynamic-
ally.

Modal Order

Allows you to change the modal order for extracting the damping values and for es-
timating the FRF for the analysis.

Frequency Tables

The first table has the same behavior as the FRF Frequency Table in the FRF Worksheet. The
second table contains the mode information for the selected Modal Order in the Stabilization
Chart Options. It only shows stable modes, both in frequency and in damping. This information
is updated when you click the Extract Curve-Fitting parameters data button.

Select or clear modes to update the Synthesized FRF in the Stabilization Chart plot and to
understand the contribution of each mode.
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Chapter 30: Welding Toolbox Extension
The Welding Toolbox is a native Mechanical extension that is designed to help manage welding process
simulation. This tool eases setup in Mechanical and helps to optimize the weld sequence and process
parameters in order to:

• Assess temperature distribution.

• Predict distortion and residual stresses.

Note:

As needed, see the Activate Beta Options (p. 1) section to make the feature available.

The following sections describe how to use the Welding Toolbox:

30.1. Enabling the Welding Toolbox Extension

30.2. Using the Welding Toolbox Extension

30.3.Weld Worksheet Operations

30.4.Weld Setup Properties

30.5. Understanding Behavior in Terms of Solver Inputs

30.6.Weld Penetration Result Object

30.1. Enabling the Welding Toolbox Extension

To enable the Welding Toolbox extension:

1. Follow the directions in Activate Beta Options (p. 1) to make the feature available.

2. In the Workbench toolbar, under the Extensions options, select Manage Extensions....

3. Select the Welding Toolbox check box to enable the extension.

4. Once loaded, the Welding Toolbox extension will appear in the Mechanical ribbon.
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30.2. Using the Welding Toolbox Extension

The Welding Toolbox supports three workflows to simulate weld object behavior:

• Transient Thermal analysis.

• Static Structural analysis.

• Transient Thermal linked to Static Structural analysis.

Transient Thermal Analysis

In this case, only temperature distribution is calculated in the analysis. The temperature results will depend
on the welding inputs (Initial Temperature/Power, Velocity) and the proper thermal boundary conditions
assigned in the model.

Static Structural Analysis

This type of analysis works under the assumption that the welding bodies have volumetric shrinkage
between an initial theoretical temperature and room temperature. This shrinkage can be calibrated to
account for the deformation of the connected bodies. A temperature distribution is not calculated in
this approach.

Transient Thermal Linked to Static Structural Analysis

This combines the previous two cases. First, the correct temperature distribution over time is calculated
based on welding inputs and thermal boundary conditions. Then, these temperatures are imported into
the structural analysis, to be used together with the mechanical setup (material properties, structural
boundary conditions) to account for the weld deformation and stress state during the welding process.

The Mechanical UI process for these three types of analysis is described in the sections below. A new
Weld Setup object has been developed, available in Mechanical once the extension is loaded.

A Weld Setup object can be inserted under a Transient Thermal or Static Structural analysis. When
this weld object is inserted, the Weld Worksheet opens in the Mechanical editor.
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30.3. Weld Worksheet Operations

The Weld Worksheet contains the following parameters and controls:

Weld Wildcard

This field is used to import the weld bodies present in your assembly by name. The wildcard
string is compared against the names of the bodies in the assembly and matches are imported
to the worksheet. The wildcard string can be a substring of the names of the weld bodies. For
example, using WELD as wildcard string will match the bodies named WELD_1 and WELD_2.
Clicking the Apply button populates the worksheet with the matching bodies.

Select Sequence Method

Three options are available to select the sequence in which the operations on the chosen weld
bodies are to be performed:

• Program Controlled: the sequence is the order in which the bodies appear in the tree
under the Geometry object.

• By Location: the sequence is determined relative to a coordinate system. When selecting
this option, two additional fields are exposed to allow you to select a coordinate system
and to select the type of arrangement with respect to the chosen coordinate system.
The options for the latter are Absolute, in which case the sequence is by absolute dis-
tance of the weld bodies from the given coordinate system, and X Dir, Y Dir, or Z Dir
, in which case weld bodies are arranged in order of distance in the chosen coordinate
system direction, from lowest to highest.

• CSV: the sequence and all other values for the worksheet can be directly imported from
a .csv file. The weld names in the .csv file are matched against the welds in the tree
and matches are populated in the worksheet.

Generate Sequence

Once the sequence method is chosen, clicking the Generate Sequence button populates the
Welding Order fields for the respective welds.

Export Sequence

Clicking this button exports the worksheet in .csv format.
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Each worksheet row has two context menu options:

Flip Weld

This can be used to flip the direction of welding for the chosen bodies.

Zoom To selection

This can be used to zoom to the weld bodies that were chosen in the worksheet.

30.4. Weld Setup Properties

A Weld Setup object has the following configurable parameters:

Selection Method

Two options are available for selecting weld bodies. Manual Input allows you to select the
weld bodies interactively or by named selections, while Weld Worksheet allows you to select
the weld bodies using the wildcard option in the worksheet.

Weld Heat Input

Three options are available to supply the load to the weld object:

• Temperature: this option allows you to assign a direct temperature to the group of
weld elements active in a specific load step.

• Power - Direct: direct heat per unit volume is applied to the weld object. This option
exposes the Direct Heat Generation parameter.

• Power - Indirect: net energy is calculated and applied to the weld object. This option
exposes the following parameters

Machine Parameter

Multiplication parameter specific to the welding tool to calibrate machine heat
deposition rate.

Voltage

Electrical voltage of the welding tool.

Current

Electrical current drawn by the welding tool.

Power is calculated as follows: Machine Parameter * Voltage * Current / Number of groups.

Thermal Strain Scaling Factor

Factor used in calculating the temperature at which the thermal strain begins acting on the
model. The melting temperature is multiplied by this factor to set the body reference temper-
ature. This is available only when the Weld Setup object is in a Static Structural environment.
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Ambient Temperature

This is used to specify the environment temperature of the weld process.

Weld Velocity

The velocity of the welding tool. This determines the Welding Time in the worksheet and is
used to automatically set the correct load step timing table.

Weld Mode

Two options are available:

• Material Deposition: Element kill and alive technology is used to create the welding
elements in order to simulate weld feeding material deposition.

• Direct Energy Deposition: Only thermal input is applied, but there is no activation or
deactivation of elements, to simulate welding process without filler material.

Elements Groups per Weld

This parameter determines the clustering or grouping of elements within a weld. The value is
used to determine the number of fractions into which the weld volume would be split during
the analysis. The number of load steps in the analysis settings is equal to the total number of
elements groups plus additional cooling time for each welding line.

Note:

Weld Direction calculation is done using the longest edge of the weld body. Welds should
be modeled as long continuous bodies where possible. The accuracy of Weld Time is de-
pendent on effective defeaturing in the model.

30.5. Understanding Behavior in Terms of Solver Inputs

This section describes the effect of some of the above parameters on the commands that are input to
the solver.

Weld Heat Input

The following behavior only applies to Transient Thermal analysis:

• Temperature: For this option, D,ALL,TEMP,%Temperature value% is supplied to
the weld selection.

• Power - Direct: For this option, BFE,ALL,HGEN,,%DirectHeatGenerationValue%
is supplied to the weld selection.

• Power - Indirect: For this option, the total power is calculated as the product of Machine
Constant, Voltage and Current. This is then divided by the volume of the weld selection
and this value is applied as BFE,ALL,HGEN,,%CalculatedValue%.
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Ambient Temperature

The specified value is used in a Static Structural analysis to define the ambient temperature.
BF,ALL,TEMP,%AmbientTemperature% is used in the solver.

Weld Mode

Two mode options are available:

• Material Deposition: adds ekill and ealive commands to the solver and is executed
according to the weld selections.

• Direct Energy Deposition: applies load without ekill and ealive commands to the
solver and is executed according to the weld selections.

Thermal Strain Scaling Factor

This factor can be used to account for unknown effects in your simulation that may affect the
final welded bodies' distortion or stress state, for example, thermal boundary conditions (which
directly affect temperature distribution) or temperature dependent material properties. It can
also be used to account for the simplifications made when using a structural standalone ana-
lysis.

The thermal deformation of a structural body is calculated as follows:

where  is the thermal deformation and  is the scaling factor.

By modifying the Reference Temperature  of a specific body, you can select at which

temperature the bodies are in a non-deformed state in the simulation.

For example, if  is defined as the initial temperature when the bodies are activated, the

initial thermal strain of those bodies would be equal to zero. This will therefore achieve the
maximum volumetric shrinkage when the bodies are cooled down to room temperature.

30.6. Weld Penetration Result Object

The Weld Penetration result object is used to visualize the effect of welding process on the temperature
profile around the weld regions.

30.6.1. Adding a Weld Penetration Result Object

30.6.2. Setting up a Weld Penetration Result Object

30.6.3.Viewing the Weld Penetration Plot
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30.6.1. Adding a Weld Penetration Result Object

To insert a Weld Penetration result object, click the Weld Penetration icon under the Welding
Toolbox Extension. This option is available only for transient thermal analyses.

30.6.2. Setting up a Weld Penetration Result Object

Specify the following information for the Weld Penetration result object.

Property Name and DescriptionCategory

Scoping MethodGeometry

Select the bodies where you want to visualize the depth of the welding
process. Valid scoping methods are:

Geometry Selection

The object is applied to a body or bodies that you choose using graphical
selection tools.

Select the desired geometry, then click Apply in the Geometry field
below the Scoping Method. This field then displays the type of geometry
(for example: Body) and the number of geometric entities (for example:
1 Body) to which the probe object is scoped.

Named Selection

Scopes the object to a geometry-based named selection.
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Property Name and DescriptionCategory

Material ID

Scopes the object to a specific material.

Penetration Temperature

The filtering temperature for assessing the depth for visuaulizing the
effect of the welding process.

Definition

By

Select the input for your results display.

• Time

• Result Set

• Maximum Over Time

• Time of Maximum

• Minumum Over Time

• Time of Minimum

Display Time

If you are displaying results by time, enter the display time for your results.
Penetration Temperature by Time indicates how much of the model
has reached the specified Penetration Temperature value by the given
Display Time. Last is the most recent display time for which there is a
solution.

Result Set

If you are displaying results by result set, enter the desired result set
number. Penetration Temperature by Result Set indicates how much
of the model has reached the specified Penetration Temperature value
by the given Result Set. Last is the most recent result set number for
which there is a solution.

This category displays the following read-only properties for the Weld Penetration
object:

Minimum

The minimum plotted value of the penetration temperature, represented
by 0.

Results
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Property Name and DescriptionCategory

Maximum

The maximum plotted value of the penetration temperature, represented
by 1.

Minimum Occurs On

The location of the minimum temperature value.

Maximum Occurs On

The location of the maximum temperature value.

30.6.3. Viewing the Weld Penetration Plot

The weld penetration plot shows the depth to which the effect of the welding process is seen, as
filtered by the Penetration Temperature. The plot's contours are defined by the Status field. A value
of 1 indicates the elements that reached a higher temperature than the Renetration Temperature
(shown in red on the plot).
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Chapter 31: Data Translator Application
The Data Translator is a beta application that converts results files between different formats. It contains
two translation applications:

• A Results Translator that converts Mechanical application results into H5 files. An H5 (or HDF5) file
is saved in the Hierarchical Data Format (HDF), which is designed to store and organize large amounts
of information. Use the Results Translator to filter and export the results of your simulation into
applications that use the H5 file format.

The Results Translator is available through the independent Data Translator application and as a
native extension in the Mechanical application.

• A Solver Deck Translator that converts input files from Abaqus into a file format that is readable by
the Mechanical application. Use it to import Abaqus models into the Ansys Mechanical application.

This application is only available through the Data Translator, which is opened independently of
the Mechanical application.

The Data Translator is only supported for the Windows platform.

Note:

As needed, see the Activate Beta Options (p. 1) section to make the feature available.

For more information about the Data Translator, see the following sections:

31.1. Accessing the Data Translator Application

31.2. Using the Results Translator

31.3. Using the Solver Deck Translator

31.1. Accessing the Data Translator Application

The Data Translator application is opened independently of the Mechanical application.

To access the Data Translator app, do the following:

1. Navigate to the following directory:

\ANSYS Inc\v251\aisol\WBAddins\MechanicalExtensions\DataTranslator

Alternatively, use the Windows search bar to find the file DataTranslator.vbs.
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2. Double click the file DataTranslator.vbs. The following dialog box is displayed.

3. Do one of the following to launch the Data Translator applications:

• Click the Results Translator button to run that application. Alternatively, you can access it
through the Mechanical application. For more information, see Using the Results Translator (p. 147).

• Click the Solver Deck Translator button to run that application. For more information, see Using
the Solver Deck Translator (p. 157).
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31.2. Using the Results Translator

Use the Results Translator to save the results of your simulation to an H5 Hierarchical Data Format
(HDF) file. The H5 (or HDF5) file format stores and organizes large amounts of information. This allows
you to export the results of your simulation to applications that use the H5 file format.

As part of this translation process, you can do the following:

• Select the compression algorithm for the exported file.

• Specify which parts of your analysis to export by scoping the export to specific results and using
named selections.

• Filter results to transform and reduce the amount of data stored in the exported file.

The Results Translator is available as both a standlone application and an extension in the Mechanical
application.

See the following sections for more information about this application:

31.2.1.Workflow for Using the Results Translator

31.2.2. Accessing the Results Translator

31.2.3. Exporting Solution Files with the Results Translator

31.2.4. Compression and Filtering Workflows

31.2.1. Workflow for Using the Results Translator

To translate solution files with the Results Translator, follow this general workflow:

1. Generate a solution for your model and review the results.

2. Access (p. 147) the Results Translator.

3. Specify the options (p. 150) for exporting results, including the compression algorithm, scoping,
and filtering options.

4. Export (p. 156) the selected results to an H5 file.

31.2.2. Accessing the Results Translator

You can access the Results Translator in two ways:

• By running the independent Data Translator application as described in Accessing the Data
Translator Application (p. 145).

• By loading it as an extension to the Mechanical application as described in Loading the Results
Translator Extension in Workbench (p. 147).

Loading the Results Translator Extension in Workbench

Follow these steps to load the Results Translator extension in Workbench:
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1. Run the Workbench application.

2. Follow the directions in Activate Beta Options (p. 1) to make this feature available.

3. Open your project.

4. Click Extensions > Manage Extensionsin the Workbench Project page. The Extensions pane is
displayed as shown below.

5. Click the check box next to Data Translator (highlighted in red above).

6. Click the Close button to save your changes.

7. Open your Workbench project in the Mechanical application. The Data Translator extension
appears in the ribbon as shown below.

Run the Results Translator in the Mechanical Application

To access the Results Transltor in the Mechanical application, do the following:

1. Add an H5 Export Object to the Solution branch of your project. Do one of the following:
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• Click the H5 Migration As Post Settings icon .

• Right-click the Solution object to open the context menu, then choose Insert > H5 Export
Object.

The Results Translator adds an H5 Export object under the Solution branch of the project tree.

2. Right-click the H5 Export object and select Generate from the menu. The Results Translator
dialog is then displayed.

H5 Export Object Status

When you create an H5 Export object, the application inserts it into the Solution tree.

The following icons and fields show the status of the H5 Export object.

• A check mark (✔) indicates that all required information has been entered for the H5 Export object
object and an H5 file was generated.

• A lightning bolt indicates that a valid H5 file has not been generated. One or more fields could be
empty or contain invalid information.

• The H5 Export Status field in the Details pane gives more information about the status of the H5
Export object.

Export awaited

An H5 file has not been generated.

Exported H5

An H5 file was successfully generated.
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See Exporting Solution Files with the Results Translator (p. 150).

31.2.3. Exporting Solution Files with the Results Translator

When you run the Results Translator, the following dialog appears. If you accessed this extension
from within the Mechanical application, the fields are pre-filled with information from the current
project.

Follow the steps below to select and export results as an H5 file.

1. Select the results file (p. 150) to be exported. The Result Translator dialog shows informa-
tion (p. 151) about the selected file.

2. Select the compression type. (p. 152).

3. Select the specific solution results (p. 153) to be exported.

4. Optionally, edit the export settings (p. 154).

5. Export the results (p. 156) to an H5 file.

Select the Result File

To select the result file to convert:
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1. Enter the file name and directory path in the Select Result File field. Alternatively, click the
Browse button to navigate to the desired file. The supported file formats are *.rst, *.d3plot,
*.rth, and *.h5.

2. Click Read Results File to load the selected file.

Note:

If the name of the result file ends with _0 (or another number), the Results Translator as-
sumes that it contains results from a distributed solution. The extension then searches for
other files with the same name and attempts to load them. If the Results Translator suc-
cessfully loads the distributed result files, it processes the files in parallel.

View Information About the Results

The following fields display information about the selected results file.

General Result Information

Analysis Name

The name of your Ansys project.

Physics Type

The solver that generated the solution.

Analysis Type

The type of simulation that was performed.

Solver Version

The release version of the solver.

Unit System

The system of measurement for the project.

Mesh Information

Click Mesh Information to view information about the model's finite element mesh, including the
number and types of nodes and elements.
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Time Information

Click Time Information to view the time and frequency steps in the result file.

Select Compression Type

Use the Global Settings fields to select the compression algorithm and specify its settings.

Compression Type

Choose the compression algorithm that is used to export the result file. Numeric values with integer,
float, and double data types are compressed.

• ZSTD (default) uses the Zstandard algorithm for fast lossless data compression

• GZIP uses the DEFLATE algorithm for data compression
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• None performs no data compression

Level

(ZTSD and GZIP only.) Determines the level of compression. Low values typically result in lower
compression rates with high compression and decompression speed. Increasing the compression
level increases the compression rate at the expense of performance.

The available compression levels for both ZSTD and GZIP are between 1 and 20. The default
compression level is 1. Values higher than 6 for ZSTD and 3 for GZIP are rarely useful. The improve-
ment to the compression rate is low compared to the additional time it takes to compress the
data.

Number of threads

(ZTSD only.) You can optionally increase the number of threads used during the compression step.
The default is 4 threads.

Export Floats

Specifies whether all available data is exported as floating point numbers. The default (True) is
that degree of freedom (DOF) results are exported as double precision numbers while elemental
results are exported as floating point numbers.

Select Results for Export

The Result table displays the available results from the selected result file. The rows list the types of
results stored in the file and the columns list the default export settings for individual results.

1. To select a row of results for export, click the check box under Export in the Result table.

2. Optionally, you can modify the export settings for a result by double-clicking anywhere in that
row of the table. See Editing Results Export Settings (p. 154) for more information.

Export

Selects individual results for export.

Result

The outputs from the simulation.
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Set Scoping

Controls selected sets for a particular result, enabling users to only export a subset of the
times/frequencies stored in the original result file.

Mesh Scoping

Selects the parts of the model where a particular result is exported. In the Mechanical application,
this is done by using named selection.

Rotate to Global

Whether the results are rotate to the global coordinate system.

Requested Location

Specifies how the exported results are stored.

Compression Workflow

Specifies the compression workflow algorithm. See Compression Workflows  (p. 156).

Filtering Workflow

Specifies the filtering workflow algorithm. See Filtering Workflows  (p. 157).

Editing Results Export Settings

You can optionally edit the values of the export settings for individual rows in the Results table:

1. Double-click the row of the table that contains the desired solution results. The Edit Results
dialog shows the name of the result.

2. Modify the desired export settings.
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3. Click Apply to save your changes.

You can edit the following settings:

Set Scoping

Select the solution time steps and frequencies to export. The default is All.

Named Selection

Select the desired named selection from the drop-down menu. The default is All.

Rotate to Global

If set to True (default), this option rotates the results to the global coordinate system.

Note:

If Rotate to Global is set to False, the coordinate system rotation cannot be
changed in the exported file. This setting cannot be modified upon reading the
exported file using Data Processing Framework (DPF) operators.

Requested Location

The location of the solution. Select one of the following:

Nodal (default): the mean

Elemental: the elemental mean

ElementalNodal: the unaveraged

Compression Workflow

Specifies the workflow for compressing the results file.

None (default)

POD Compression

Enhanced POD Compression

For more information, see Compression Workflows  (p. 156).

Filtering Workflow

Specifies the workflow for compressing the results file.

None (default)

Convert to Skin

Corner Nodes

For more information, see Filtering Workflows  (p. 157).
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Exporting Results to an HDF5 File

When you finish specifying the settings for your export, do the following to convert the selected
results to HDF and save them in an H5 file:

1. To save the exported results in one H5 file, select Merge Results to a Single h5 File.

2. Click Export Results as HDF5.

Depending on the size of your model and your available computing resources, this may take a few
minutes.

The Results Translator saves the H5 file under the same name and directory path as the selected
results file. For example, if you selected file.rth, the exported file is saved as file.h5 in that
directory.

The file h5Log_file.log stores status messages for the conversion process.

31.2.4. Compression and Filtering Workflows

Compression Workflows

Data passed through the compression workflow can be compressed with one of the following lossy
algorithms.

POD Compression

Proper Orthogonal Decomposition (POD) compression captures the most relevant aspects of the
data by discarding insignificant information,

Enhanced POD Compression

This enhanced version of POD compression uses additional vectors to reconstruct more accurate
results by capturing the discrepancies between the original data and its "smooth" representation.

Both workflows allow you to choose the desired threshold for compression. The threshold value is
based on the desired precision of the decompressed data. This value should be between 0 and 1,
where 0 gives the maximum possible precision of the decompressed data with the asked earlier
threshold and 1 gives the results from POD compression. The default value for the compression
threshold is 1e-4.

Important:

Ansys recommends that you use these two workflows only on the results of a static, tran-
sient, or harmonic analysis. For mode superposition analysis, use the On Demand Expansion
procedure and the existing modal basis instead of POD or Enhanced POD compression.
For more information about this solution option, see the discussion of modal analyses in
Analysis Types and Analysis Settings and Solution.
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Filtering Workflows

Filtering workflows are used to transform and reduce the number of data stored in the result file.

Convert to Skin

Reduces the amount of data stored in the result file by only storing the results on the outer skin
of the model. This workflow transforms the mesh so that only skin nodes are kept. It then creates
a new layer of surface elements to map the surface of the model. The original mesh and volume
results are discarded unless some other results use a different option.

Corner Nodes

Used only in models with quadratic elements (such as Hex20, Tet10, or Quad8). In these models,
associated results are typically stored in mid-side nodes because these nodes are used in the
solution. In some cases, you might want to discard these results because corner nodes have
enough information to represent an accurate enough solution.

When you select this workflow, the solution will be extrapolated to the mid-side nodes when
reading the result file. This creates a different solution for these nodes as a simple interpolation
will be performed.

Normalized High Pass Filter

Filters small values from the result file. This is useful in models where the interest zone is small
or there is a concentration of stresses in a particular zone. Enter a threshold for the maximum
value of the result for the step that will be used for filtering.

31.3. Using the Solver Deck Translator

Use the Solver Deck Translator to convert Abaqus input files to Ansys-readable *.cdb and related files.
You can then import the converted file into the Ansys Mechanical application.

This application is only available through the Data Translator, which is opened independently of the
Mechanical application.

See the following sections for more information about this tool:

31.3.1.Translating Abaqus Files

31.3.2. Solver Deck Translation Results

31.3.1. Translating Abaqus Files

To use the Solver Deck Translator to translate Abaqus files:

1. Run the Data Translator as described in Accessing the Data Translator Application (p. 145).

2. Click Solver Deck Translator. The following dialog box is displayed:
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3. Choose the Abaqus file you wish to convert. Enter the file name and directory path of the Abaqus
result file in the Select Input File field. Alternatively, click the Browse button to navigate to the
desired file and load it. The supported file format is Abaqus input format (*.inp).

4. Click Translate to launch the translation process.

The Log area displays information about the status of the translation. See the discussion of the
summary file under Solver Deck Translation Results (p. 159).

5. Click Open output folder to open the folder in which the translated files are stored. By default,
this is the same directory as the input file.
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6. Click Return to close the Solver Deck Translator and returns to the Data Translator. Click Exit
to close all applications.

31.3.2. Solver Deck Translation Results

The Solver Deck Translator generates the following files, which are stored in the same directory as
the Abaqus input file. filename is the name of the input file.

filename.cdb

A Coded Database (CDB) file that contains the translated model.

filename_server.txt

A text file that logs errors and warnings from the Ansys Prime Server.

filename_summary.txt

A log file that summarizes the translation process and lists any errors that may have occurred.
This file is also displayed in the Log area of the Solver Deck Translator dialog.

filename_Run_MAPDL.dat

The Mechanical APDL input file generated for the model.

filename_PyPrime.txt

Logs Python-related errors during the translation process.
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Chapter 32: Strain Scaling Factor Tables
A new dependent variable – Strain Scaling Factor (Beta) – was added to the Tables function. The
strain scaling factor (SSF) is a direct multiplier to predicted strain values in laser powder bed fusion
(LPBF) additive simulations using the LPBF Process Add-on. It is used as a calibration factor to account
for differences in machines and materials.

The table function allows you to specify strain scaling factor values that vary by location (that is, by X
and Y-coordinates). For more information on how to use strain scaling factor tables, see Location Spe-
cific Strain Scaling Factor (Beta) in the Additive Manufacturing Beta Features.

Requirements and Limitations for Strain Scaling Factor Tables

Be aware of the following when you are creating tables that include strain scaling factor values.

• The dependent variable Strain Scaling Factor is only used by the LPBF Process Add-on. The Mech-
anical APDL solver ignores this variable for other simulation types.

• Select X Coordinate and Y Coordinate as the independent variables for strain scaling factor tables.
The LPBF Process Add-on ignores other independent variables.

• Strain scaling factor tables must follow the Table Requirements and Limitations.
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